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updates to this manual.
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DVD, or visit us online at www.mohrtm.com. (Please click on Products, CT100,
Downloads.)
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Warranty
Purchase and/or use of this product signifies your agreement to the terms of this
Warranty. MOHR Test and Measurement LLC (MOHR) warrants that this
product will be free from defects in materials and workmanship for a period of
one (1) year from the date of shipment unless otherwise stated in writing by
MOHR. If any such product proves defective during this warranty period,
MOHR, at its option, will either repair the defective product without charge for
parts and labor, or will provide a replacement in exchange for the defective
product. MOHR’s liability and Buyer’s remedies under this Warranty shall be
limited solely to repair, replacement, or credit.
In order to obtain service under this Warranty, customers must notify MOHR of
the defect before the expiration of the warranty period and make suitable
arrangements for the performance of service. Customers shall be responsible for
packaging and shipping the defective product to MOHR with shipping charges
prepaid. Customers shall be responsible for paying all return shipping charges,
duties, taxes, and other charges for units returned to any location. Customers
shall be responsible for removing and reinstalling the equipment and for any
decontamination procedures that may be necessary in preparation for
shipment.
THIS WARRANTY IS EXCLUSIVE AND IN LIEU OF ANY OTHER
WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING BUT NOT
LIMITED TO, ANY IMPLIED WARRANTY OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. MOHR SHALL NOT BE
LIABLE UNDER ANY CIRCUMSTANCES FOR CONSEQUENTIAL OR
INCIDENTAL DAMAGES, INCLUDING BUT NOT LIMITED TO LABOR
COSTS OR LOSS OF PROFITS, DAMAGE TO PERSONS OR PROPERTY
ARISING IN CONNECTION WITH THE USE OF OR INABILITY TO USED
PRODUCTS PURCHASED FROM MOHR.
Specific limitations of this Warranty:
This Warranty only applies to normal and reasonable use of this
product. Damage to this product resulting from improper use, the
determination of which is solely at the discretion of MOHR, is
specifically excluded from this Warranty.
Any electrical damage to this product resulting from connection of a
cable or device carrying a static electrical charge to the front panel
BNC connector or SMA connector without first properly grounding
the conducting elements of the cable or device is specifically excluded
from this Warranty.
Any Electrical damage to this product resulting from connection of a
cable or device carrying an electrical signal or other non-zero
electrical potential relative to earth ground to the front panel BNC
connector or SMA connector is specifically excluded from this
Warranty.
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Contacting MOHR
Phone
+1-888-852-0408

Mail
MOHR Test and Measurement LLC
2105 Henderson Loop
Richland, WA 99354
USA

E-mail
Sales: sales@mohrtm.com
Technical Support: techsupport@mohrtm.com

Web
www.mohrtm.com
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1. General Information
1.1. Product Description
The MOHR CT100B TDR Metallic Cable Analyzer uses a form of closed-circuit
radar known as time-domain reflectometry (TDR) to test cables for defects or
“faults”. The instrument applies a fast rise time broadband step signal to the
cable under test and then measures the reflected voltage at very short time
intervals. The resultant TDR trace allows the operator to identify changes in
impedance along the length of the cable indicating the presence of faults such as
opens, shorts, kinks, defects in the shield or conductor, foreign substances such
as water, thermal damage, among others. The CT100B provides sophisticated
signal processing software that lets users analyze the frequency-domain
characteristics of the TDR trace, replacing a handheld vector network analyzer
(VNA) or frequency domain reflectometer (FDR) for many applications. With
the CT100B TDR Cable Analyzer a user can detect, localize, and characterize
almost any cable fault in both the time and frequency domains.
Please note that with the release of the CT100B, the CT100HF instrument has
been updated with the CT100B hardware, firmware, and software
improvements. Any reference to the CT100B in this manual also applies to the
CT100HF unless specifically stated.

1.2. Power Requirements
The CT100B may be operated using either the supplied AC adapter or internal
NiMH batteries (for a minimum six hours operating time, typical use). The
internal NiMH battery charges under AC during normal operation.
The external AC power adapter (pn CT100-AC-PS) operates on 100-240V AC
at 50-60 Hz and draws a maximum current of 1.5A. Use of a grounded AC
socket (US 3-prong or EU 3-prong) is essential for safe operation of the CT100B
with the included AC power adapter. Review the Safety Summary section
before operating the CT100B.

1.3. Options and Accessories
Options and accessories available for the CT100B are described in
Section 6, Options and Accessories.
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1. General Information

1.4. Unpacking and Initial Inspection
Before opening the shipping package containing the CT100B, first inspect it for
signs of damage. If there is evidence of damage to the shipping package, notify
both the shipping carrier and MOHR.
The shipping container should contain the CT100B and standard accessories,
including this Operator’s Manual, front panel cover, external AC adapter and
power cord, soft transit case, and calibration fixture(s). If the shipping container
is intact but there are missing items or if the CT100B is damaged, defective, or
does not meet operational requirements, contact a MOHR-authorized sales
representative.

1.5. Repacking for Shipment
In the event that the CT100B needs to be shipped to a MOHR-authorized
service center for repair, calibration, or other service, contact MOHR for an
RMA number. Affix a label to the outside of the shipping container indicating:
• RMA number
• name, address, phone, and email of the owner
• name of the MOHR service representative who was contacted regarding
the shipment
• serial number of the instrument
• description of the problem with the instrument and/or the desired service
or maintenance
Optimally, the original shipping carton and packing material should be used to
repack the CT100B for shipment. Otherwise, the following steps should be
taken:
1. Place CT100B in ESD-safe (Electro Static Discharge) Bag.
2. Wrap with 3 in. of anti-static bubble wrap or non-movable foam
cushioning. DO NOT USE packaging peanuts.
3. Place in a sturdy cardboard box and fill any additional void with
packaging material. DO NOT USE packaging peanuts.
4. Include any Purchase Orders, Work Orders, or special instructions with
shipment.
5. Write the RMA number on outside packaging.

2
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2. Safety Summary
The safety information presented in this brief summary is only intended for
operators of the CT100B. Safety information relating to specific circumstances is
present throughout this manual and is not necessarily present in this summary.
Please read this manual in its entirety before using the CT100B and take note of
safety information not included in this summary.

2.1. Terms in the Manual
WARNING: Refers to conditions or practices that could result in personal injury or loss of life.

CAUTION: Refers to conditions or practices that could result in damage to this product or other products and in some
cases could void the Warranty.

2.2. Terms on the CT100B
2.2.1. DANGER
Indicates an injury hazard immediately accessible.

2.2.2. WARNING
Indicates an injury hazard not immediately accessible.

2.2.3. CAUTION
Indicates a hazard to property including the product.
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2. Safety Summary

2.3. Symbols in the Manual

2.4. Symbols on the CT100B

2.5. Static Charge
Any cable or wire can carry a significant static electric charge that could
damage the sensitive internal electronics of the CT100B. For this reason, it is
essential to discharge the electrical conductors of any cable or device-under-test
(DUT) by shorting them to each other or to earth ground before connection is
made to the CT100B’s sampling circuitry.
CT100B instruments supplied with a front panel BNC test port are equipped
with a built-in internal self-grounding connection that briefly shorts the
conductors of the DUT to each other, dissipating stored charge, before
completing the connection to the CT100B’s sensitive internal sampling circuitry.
For this reason, the last cable connection should always be made to the CT100B
test port. For example, if the DUT is a cable assembly, all internal connections
within the cable assembly should be made before connection is made to the
CT100B BNC test port. This ensures that all stored charge in the DUT is
discharged during the connection to the CT100B BNC test port.
Sometimes it is convenient to insert a patch cable between the CT100B BNC
test port and the DUT. In this case, it is recommended that all cable
connections, including the connection of the patch cable to the DUT, be made
before connecting the patch cable to the CT100B BNC test port. Otherwise, the
BNC test port self-grounding safety feature is circumvented.
If for some reason the last connection cannot be made at the CT100B test port,
then the conductors of the DUT should be discharged (shorted) manually using
an industry-standard shorting cap termination or equivalent direct electrical
connection.
Note that CT100B instruments equipped with SMA or other front panel test
ports do not have internal self-grounding protection. Therefore, when using
these instruments, the conductors of the cable under test/DUT should always
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be shorted to each other or to earth ground prior to connection to the CT100B’s
test port.
CAUTION: Failure to properly ground the cable/device under test prior to connecting it to the front panel connector,
either directly or indirectly, could result in damage to the
sampling electronics and will void the Warranty.

2.6. Fuses
There are no external fuses or breakers accessible to the user. However, there
are two internal automatic thermal breakers that disconnect the power from the
charger and battery to the rest of the system. These thermal breakers make an
audible click when they actuate, and the CT100B turns off. One of the circuit
breakers automatically resets after time. When this breaker cools, the CT100B
can be restarted, but the CT100B should be serviced by qualified personnel.
There is also an internal breaker on the power board. If tripped, this breaker
must be reset manually and the instrument should be serviced by qualified
personnel.
CAUTION: If the thermal breakers trip, the instrument
should be evaluated by qualified service personnel for maintenance.

2.7. AC Power Source
The CT100B is intended to operate only from a 120 VAC or 240 VAC RMS
power source using the CE- and UL-approved 24 VDC external power
supply/adapter (pn: CT100-AC-PS) provided with the instrument.
WARNING: Only use the power cord supplied with the instrument, and then only if the cord is in good condition. Refer all maintenance regarding the power supply or power cord
to qualified service personnel.
CAUTION: Use of any power source other than the supplied
external power adapter(s) could damage the instrument and
may void the Warranty. Use only MOHR-approved accessories.
WARNING: To reduce the risk of electric shock, disconnect
all external cables before connecting the 24 VDC external
power supply.
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2.8. Grounding the CT100B
When the CT100B is connected to the external AC adapter, the CT100B
chassis, front panel USB, screen, and controls are grounded through the
grounding conductor of the power cord. To avoid electrical shock, it is essential
that the protective ground connection is present when operating the unit under
AC power. When disconnected from external power, the CT100B is floating
relative to earth ground, unless one of the USB ports is connected to a grounded
device. In this case, the ground of the USB device is common with the CT100B
chassis, screen, and electronic controls. An isolated ground power supply is an
optional accessory available upon request.
At all times, the front panel BNC or SMA connector is floating and is isolated
by at least 500 VDC from the remainder of the CT100B. This eliminates
measurement errors caused by common-mode noise and slight ground-potential
differences in the cable/device under test. However, care should be taken with
respect to electrical safety, as the front panel BNC or SMA shield is never safely
grounded unless connected to a safely grounded cable or device and can be
considered a second live conductor if connected to a cable or device carrying a
non-zero electrical potential relative to earth ground. This situation carries the
risk of electric shock.
WARNING: The BNC or SMA connector shield represents a
floating ground and is never safely grounded even with the use
of a properly grounded AC adapter. Never use the CT100B to
test any cable or device carrying a non-zero electrical potential relative to earth ground, as this could render an electric
shock.

2.9. Danger Arising From Loss of Ground
When disconnected from the AC power adapter, the CT100B is no longer
grounded unless connected to a grounded USB device at the front panel host
USB port. Because the test port connector shield is floating relative to the
remainder of the instrument, the test port connector may be operating at an
elevated voltage even when the AC adapter is connected. Therefore, the test
port connector should never be used to test any cable or device with an
electrical potential relative to earth.
WARNING: Upon loss of the protective-ground connection,
all accessible parts, including the screen, knobs, and connectors, can render an electric shock.

2.10. Explosive Atmospheres
Do not operate the CT100B in an explosive atmosphere unless your unit has
been specifically certified for that condition. Explosive Atmospheres: MIL-STD
810G, Method 511.5, Procedure I (+55◦ C, sea level to 4600 m).

6
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2.11. Do Not Remove Covers or Panels
To avoid personal injury and risk of electric shock, do not open the CT100B case
unless replacing the battery and do not operate unless the case is fully intact.
WARNING: Disconnect power, USB, Ethernet, and test cables prior to opening the CT100B case to replace the battery.
Failure to do so can render an electric shock.

2.12. Connecting Cables to the Test Port
To avoid damage to the CT100B and the very sensitive sampling electronics
associated with the front panel BNC or SMA connector, do not connect it to
any cable or device that can be driven by active circuitry or is subject to
transient voltage spikes.
WARNING and CAUTION: The instrument should never be
used to test any cable or device carrying live electrical signals,
as this carries a risk of electric shock. This could also damage
the sampling electronics and will void the Warranty.
CAUTION: Always properly ground the conductor(s) of any
cable or wiring to remove any static charge prior to connecting it, either directly or indirectly through attachment to
another cable, to the CT100B’s front panel test port connector. Failure to do so can damage the instrument’s sensitive
sampling electronics and will void the Warranty.

2.13. Battery Replacement and Disposal
The CT100B contains an internal battery pack. The internal battery pack is
2700 mAh, NiMH, 12 AA cells, 14.40 volts, 38.88 Wh. There is also a 120 mAh
lithium button cell of 2.8 volts and 0.336 Wh. Depending on the state or local
jurisdiction, these batteries may require special disposal and/or recycling.
Contact your local authorities for safe disposal in your area, or you may return
them to MOHR for recycling.
WARNING: The battery pack must be replaced with MOHR
pn: CT100-AC-B2700. Use of any other battery pack will
damage the instrument and pose a danger of fire.

CAUTION: User replacement of components is limited. Multiple warranty seals are installed on components within the
CT100B. Removal or damage of these seals voids warranty.
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3.1. Overview
If you would like a detailed explanation of TDR measurement theory and
applications before using the CT100B, please read Section 5, TDR Measurement
Theory.

3.1.1. Handling
The CT100B is designed to meet the rigors associated with normal instrument
use both in the field and on the benchtop. Care should be taken to protect it
from excessive mechanical shock, vibration, static electrical charges, and water
hazards.
The CT100B front panel is protected from impact by a snap-on front cover. The
carrying handle rotates 360° and can be used to support the instrument for
bench-top use.
The CT100B is not watertight and must be protected against water spray. If
the unit is subjected to water spray, first turn off the unit with the
battery-disconnect power switch on the rear panel and then drain all of the
excess water from the case and allow it to dry completely.
As noted in the Safety Summary and elsewhere, the CT100B is sensitive to
damage introduced by electrostatic discharge. Always properly ground the
conductors of a cable to each other or to earth ground before attaching it, either
directly or indirectly, to the front panel BNC, SMA, or other test port. Failure
to do so could damage the sampling electronics and void the Warranty.
The CT100B can be stored in temperatures of between -20°C to +60°C with or
without a battery installed and can be operated from 0°C to +50°C.

3.1.2. Powering the CT100B
The CT100B can be powered through the included 120/240 VAC (RMS) to 24
VDC external power adapter. This adapter has sufficient capacity to charge the
internal battery from a dead battery state while the unit is under operation.
The internal battery will allow the unit to operate using power conservation
techniques for periods of at least 6 hours under typical use. Automatic
power-down occurs after a variable amount of time of inactivity, selectable in
software by the user. The screen also can be set to turn off after a set amount of
inactivity. A heavily discharged battery will require 4 hours to reach full
charge.
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Fusing is internal and based on thermal reset switches and a manual-reset
breaker. If one of these fuses trips, it may indicate that a hardware malfunction
has occurred and the instrument should be evaluated by qualified personnel.

3.1.3. Caring for the Battery
The CT100B has an intelligent battery-charging circuit that dynamically
determines the optimum charge rate and reverts to low-level trickle charge when
the battery is fully charged. Charging is automatic and there are no
charge-length restrictions.
The battery should be charged between 0◦ C and +45◦ C. Battery operation
should be limited to between 0◦ C and +50◦ C. Batteries should be stored
between -20◦ C and +60◦ C. If the battery pack is older, it may not show a 100%
charge capacity even when the maximum battery charge is obtained.
CAUTION: Do not attempt to charge the battery pack below
0◦ C or above +45◦ C. Batteries should not be stored below
-20◦ C or above +60◦ C.

3.1.4. Charging and Power Status
The CT100B operates from a 24 volt power adapter or the internal battery
pack.
In the Power menu, a submenu of the Settings menu, the user can set power
save and shutdown timers. Different timeout values can be set for when the
CT100B is using the AC/DC converter or batteries. In power save mode, the
screen goes blank and only enough power is used to monitor for user input.
When input is received, the CT100B resumes normal operation. When the
shutdown timer expires, the CT100B will turn off.
A battery indicator can be toggled on or off with the Power Display menu option
in the Power menu. The indicator will show the level of charge in the battery.
It will also show if the 24 volt adapter is attached and providing power.

3.1.5. Batteries and Long-Term Storage
The CT100B has NiMH internal batteries. These batteries will drain if the
CT100B is left in storage over long periods. To preserve battery charge for as
long as possible during storage, make sure the power switch on the back of the
CT100B is set to the OFF position. After several months of storage, the internal
batteries may be completely drained. Allow up to 4 hours for the first recharge
of the CT100B after coming out of long-term storage.
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3.1.6. Low Battery
When a low battery condition is first encountered, the CT100B alerts the user.
Internal Battery Low text appears on-screen in red when the battery
percentage left drops below 20 percent.

3.1.7. Nameplate
The CT100B has a nameplate label affixed on the back of the case. See
Figure 3.3 for positioning. The nameplate includes Cage Code, Model Number,
Serial Number, NSN, a warranty expiration date, electrical input information,
and a 2D barcode containing the identifying information. See Figure 3.1 for an
example nameplate label.

Figure 3.1. Example nameplate label found on back of a CT100B.

3.1.8. Discharge Warning Label
The CT100B has a warning label above the test port on the front of the
instrument. This label warns the user to discharge any cable or device before
connecting it to the test port. See Figure 3.2 for location and contents of the
label.

3.2. License Codes
Each CT100B requires a unique license code to operate. Without the correct
code, menus and buttons still function, but there will be no live trace displayed
on the screen. The correct code for a particular device can be requested from
MOHR. Installation instructions will be included with the license code.
Depending on how it was purchased, the instrument may be supplied with either
a 30-day demonstration license or permanent license. Current license
information can be found by pushing the blue MENU button and navigating to
Settings → Info → License → License Info. A dialog showing license date and
active features will appear. When the CT100B has a permanent license
installed, appropriate options will be active. When the instrument has a
demonstration license, the dialog will show a future license date and the
instrument will provide appropriate warnings to the user as the expiration date
gets closer. If your CT100B has a license with pending expiration and you are
unsure how to upgrade to a permanent license, please contact MOHR.
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3.3. Preparing to Use the CT100B
Before using the CT100B, make sure you have read and understand the Safety
Summary section and power requirements described in Section 3.1.2 through
Section 3.1.6. If you would like a detailed explanation of TDR measurement
theory and applications before using the CT100B to test cables, please
read Section 5, TDR Measurement Theory.
Otherwise, remove the front cover and turn on the power. You are ready to test
cables using the most versatile and sophisticated portable TDR instrument on
the market.

3.4. Front Panel Controls and Connectors
The following numbered items describe the controls and connectors identified in
the front panel diagram (Figure 3.2) and described in the text below.

Figure 3.2. Diagram of the CT100B front panel.
1. POWER (red) button. Pressing this button turns the instrument on when
the main power switch on the rear panel is in the ON position. Pressing
the POWER button when the unit is on will turn the unit off after
verification that you really wish to power down. If the POWER button is
held in for several seconds, the unit will turn off regardless.
2. H1 function button. Function depends on menu.
3. H2 function button. Function depends on menu.
4. H3 function button. Function depends on menu.
5. H4 function button. Function depends on menu.
6. MENU (blue) button. Push to display the top-level menu screen. If a
menu is already on the screen, this button will clear the menu. The
previous menu will be displayed. This button also activates on-screen help
when held down while pressing other buttons.
7. VERTICAL POSITION knob. Controls the vertical position of the
currently selected trace. Trace selection is controlled by the SELECT
button (14).
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8. VERTICAL SCALE knob. Controls the vertical scale, which is displayed
on the bottom of the screen. This control modifies the appearance of the
currently selected trace. The scale is expanded about the vertical center of
the screen.
9. HORIZONTAL POSITION knob. Controls the horizontal position of the
active cursor. Displayed trace positions are moved horizontally if the
cursor is moved toward the edge of the screen to keep the cursor on-screen.
10. HORIZONTAL SCALE knob. Controls the horizontal scale of displayed
traces. The scale is expanded about the active cursor.
11. BNC or SMA test port. This connects to the cable to be tested. Be sure
to properly ground the cable before connecting it to test port in order to
prevent electrostatic damage to the CT100B’s sensitive sampling circuitry.
CAUTION: All static charge must be drained from the cable
to be tested prior to connecting to the test port (11). This
is done by shorting the cable center conductor to the cable
sheath/ground return. If this procedure is not followed, the
sampling electronics can be damaged and will void the Warranty.
12. Host USB port. This USB (V1.1) connection can be used to interface to a
client USB device such as a barcode reader, keyboard, or flash drive.
13. FILE button. Opens the File menu, which contains a database of user
configurations, saved cable records (scans), and a Vp database for known
cable types.
14. SELECT button. Used to select between traces on the screen. It has no
effect if there are no other traces. Note: When the SELECT button is
held down, press the M-FUNC button. The CT100B will generate a
screenshot that can be saved to a USB drive.
15. CURSOR button. This button is used to toggle between the two available
cursors. Pressing and holding the CURSOR button for one second and
then releasing the button will bring both cursors onto the screen.
16. SCAN button. Displays a specialized soft-menu that brings up the Scan
menu.
17. AUTOFIT/HELP (orange) button. Opens the on-screen help library
along with Autofit soft-menu options.
18. M-FUNC (multifunction) button. The function of the M-FUNCTION
knob (19) is set by this button. The current operation is displayed on the
screen (top-center).
19. M-FUNCTION (multifunction) knob. This knob adopts the function
selected through the use of the M-FUNC button (18). It also allows users
to scroll through dialog box options.
20. V1 function button. Function depends on menu.
21. V2 function button. Function depends on menu.
22. V3 function button. Function depends on menu.
23. V4 function button. Function depends on menu.

3.5. Rear Panel Connectors and Switches
The following numbered items describe the connectors and switches identified in
the rear panel diagram (Figure 3.3) and described in the text below.
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Figure 3.3. Diagram of the rear panel of the CT100B/CT100HF.
24. 24 VDC power adapter plug. The provided 24 VDC AC adapter plugs into
this port. Only MOHR-approved positive center tip, 24V adapters may be
used.
25. Client USB connection. Allows the CT100B to be connected to a host
computer for data transfer and PC control.
26. RJ-45 Ethernet port. This is a 10/100 Mb Ethernet port that can be used
for data transfer and remote PC control.
27. Power switch. This is a manual ON/OFF power switch that turns the
device off and disconnects the power from the internal electronics so the
unit can be stored and/or shipped safely.

3.6. Keyboard Alternate Controls
If a keyboard is plugged into the front panel USB port, alternate hotkey controls
are available for all front panel buttons and knobs.
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.

F1-F4 map to H1-H4.
F5-F8 map to V1-V4.
F9 maps to the blue MENU button.
F10-F12 map to the M-FUNC, SCAN, and SELECT buttons.
Shift F10-F12 map to AUTOFIT/HELP, CURSOR, and FILE.
Vertical arrow keys adjust the VERTICAL POSITION knob.
Horizontal arrow keys adjust the HORIZONTAL POSITION knob.
Shift vertical arrow keys adjust the VERTICAL SCALE knob.
Shift horizontal arrow keys adjust the HORIZONTAL SCALE knob.
Shift F7 rotates the M-FUNCTION knob counter-clockwise.
Shift F8 rotates the M-FUNCTION knob clockwise.

Note: Some functions may require multiple button pushes to take effect.
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3.7. Setting up the CT100B
3.7.1. Setting Date and Time
The date, time, and time zone must be accurately set for saved data in the
CT100B to be correctly time-stamped.
1. Change the date and time by pressing the MENU button. This calls up
the Main menu.
2. Select the Settings soft-menu option and then select the Info menu.
3. Select the Time menu option. The Time menu appears.
4. Select the Set Time Zone menu option. A dialog box listing all time zones
appears on the screen.
5. Use the M-FUNCTION knob to scroll through the list of time zones.
Highlight the correct time zone.
6. Choose the Select menu option. The CT100B may prompt you to restart.
If so, restart the unit and return to the Time menu. The CT100B is now
set to the correct time zone.
7. Ensure the menu option for daylight savings reads Daylight Savings On,
indicating that this setting is on. If the option reads Daylight Savings Off,
then press the menu button to toggle it. The CT100B may prompt you to
restart. If so, restart the unit and return to the Time menu. The CT100B
will automatically adjust for daylight savings on the correct dates.
8. Select the Time/Date menu option. A dialog box used to set the date and
time appears. See Section 3.7.2 for methods of navigating and entering
data into a dialog box.
9. Press the OK menu option when the correct time and date have been
entered.

3.7.2. Navigating Dialog Boxes
For an example of a dialog box with multiple entries, press the blue MENU
button, then Settings, then Info, then Time, and then Time/Date. Scroll
through the different entry boxes with the M-FUNCTION knob. With an entry
box selected, press the Show Keyboard menu option to call up an on-screen
keyboard.
With the on-screen keyboard chosen, select the desired characters with the
M-FUNCTION knob, pressing the Select Highlighted menu option for each one.
Get more character options by selecting the Shift menu option. Delete the
character before the cursor with the Backspace menu option.
With the keyboard open, accept the current entry with the Hide Keyboard menu
option or revert to the original entry with the Cancel menu option. Both
options remove the on-screen keyboard from the screen.
With the keyboard off the screen, select the OK menu option to accept all
changes to the current dialog box and close the dialog box. Select the Cancel
menu option to close the dialog box while canceling all changes.
With a USB keyboard attached, entries can be changed directly. Use the Tab
key to scroll down through entry boxes and hold down Shift and press Tab to
scroll up through entry boxes. Use Backspace to delete the character before the
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cursor and use the arrow keys to move the cursor left or right. Press Enter for
OK or Escape for Cancel.
3.7.2.1. Scrolling Dialog Boxes
Some dialog boxes present a list of items to be selected. For an example of this
type of dialog box, press the FILE button, and then press Cable Scan Records
(see 3.11.8 and Figure 3.24). Use the M-FUNCTION knob to highlight
individual items for selection, and then use the Select option to choose the
highlighted item. Where appropriate, multiple items can be marked for selection
using the options on the right-side menu: Toggle Selected, Clear All, and Mark
All. When an individual item is marked, it will appear in a different color.

3.8. Display Features
The CT100B screen provides the operator with numerous features that may be
useful in different cable testing situations. Figure 3.4 shows some of the typical
features you will encounter during use. Many other features are available,
however, and most of them are configurable by the user. These features are
described in detail in the following sections.

Figure 3.4. Screenshot showing typical features of the CT100B.

3.9. Menu Selections and Function Buttons
3.9.1. M-FUNC Button
The M-FUNC button is used to switch between functions Brightness, Shift,
Smooth, and Vp (and Fine/Coarse Vp) shown in the Multifunction indicator at
the top of the display screen.
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Brightness controls how bright the screen display is. When the CT100B is
powered on, Brightness will always be at 100 percent. Use the M-FUNCTION
knob to decrease or increase screen brightness.
With Shift selected, you can use the M-FUNCTION knob to slide the entire
displayed scan left and right. If you have a scanned or saved trace selected, Shift
will move the trace independently of the live trace or other traces on-screen.
Smooth controls how many successive scans should be averaged when drawing
the displayed trace. This is done to decrease visible noise on the trace. For more
information about smoothing, see Section 3.10.4.
Vp or velocity of propagation is the measure of the velocity of an electrical
signal within a cable expressed as a fraction of the speed of light. When Vp is
selected, turning the M-FUNCTION knob will adjust the Vp value for the
displayed cable. For more information about Vp, see Section 3.10.2.

3.9.2. SCAN Button Menu
The SCAN button displays menu selections associated with saving and
managing TDR traces and cable scan records. SCAN menu selections are shown
in Table 3.1.
Table 3.1. SCAN Button and Menu
Menu Selection

Purpose/Action

Save/Rename

Saves selected trace to internal storage.
Renames previously saved traces.

Show Sel.

Turns all traces invisible except the
currently selected trace. Select again to set
all traces visible.

Trace Only

Hide All Traces

Hides all traces except the live trace. (If
traces were previously saved, they can be
recalled from the FILE menu; see
Section 3.9.6)

Hide Selected Trace

Hides the selected trace. (If trace was
previously saved, it can be recalled from the
FILE menu; see Section 3.9.6)

Start Scan

Initiates cable scan.

Cursor/Snapshot
Cursor .......................

Switches between scan modes:
Creates a new scan of the portion of trace
between cursors using the current resolution
and smooth settings.
Saves trace as currently displayed on screen.

Snapshot .....................
Math

See Table 3.2: Math Menu.
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3.9.2.1. Math Menu
The Math menu is a menu selection under both the SCAN button and the blue
MENU button. Math menu selections are shown in Table 3.2.
Table 3.2. Math Menu
Menu Selection

Purpose/Action

FFT Tools
FFT Settings
Window

Sets window type (Hann, Hamming, etc.).

size

FFT buffer size.

Frequency Cut-Off Range

FFT display frequency cut-off.

Hide Selected Trace

Hides the selected trace.

Apply FFT

Creates FFT trace from selected trace data.

View Live FFT

Creates live FFT trace from live TDR trace.

Apply VSWR

Creates VSWR (voltage standing wave
ratio) trace from a selected complex division
or S11 trace.

Set Base

Sets base trace for complex FFT trace
division.

Complex Division

Creates complex division FFT: Divides
selected FFT by base FFT. Equivalent to
uncalibrated S11 trace when base FFT is of
a shorted test port.

Phase

Creates phase angle trace from selected
FFT trace.

Smith Chart

Toggle Smith Chart display for selected
complex division FFT or S11 trace.

SParam & Normalize Tools
S11 Calibration

Performs Open-Short-Load S11 calibration
and creates S11 trace.

Normalize Pulse Rise Time

Sets the rise time to apply to the selected
normalized trace.

S11 Options
Pre-Filter Options

Changes the filter options that smooth the
aberrations of the base traces.

Post-Filter Options

Changes the filter options that limit the
noise of the base traces.

Other S11 Options
OSL Bases Visible
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When enabled, causes the Open, Short, and
Load traces to not appear on-screen. Helps
eliminate excess on-screen clutter.
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Table 3.2 (Continued) Math Menu
Menu Selection

Purpose/Action

Align Base Traces

When enabled, the Open, Short, Load, and
DUT traces may be aligned to each other
based on the common part of the beginning
of the trace.

Calibration Standards

Brings up a table of Calibration Standard
Kits Coefficients. There is the option to
change and apply the standards.

S11 → USB (.csv)

Creates a CSV (Comma Separated Value)
file of the selected S11 trace and outputs
that file to a connected USB drive.

Phase Corr.

Off/On

Toggles the Phase Correction On/Off.

Phase Corr.

Start

Using the active time-domain cursor, sets a
new start point for the Phase Correction.

Between Cursor Off/On
/Hold
Off.......................
On........................
Hold......................

Toggle S11 Between Cursors mode:
Between Cursors Off.
Between Cursors On – the active section will
adjust with time-domain cursor movement.
Between Cursors Hold – the active section
will remain regardless of cursor movement.

Hide Selected Trace

Hides the selected trace.

Reapply S11

Adjusts the time-domain settings to match
those used for the selected live S11 trace.

Apply Normalization

Create normalized TDR trace based on the
selected S11 trace.

Cable Loss

Changes selected S11 trace to Cable Loss
(S21 /insertion loss) trace. Terminate cable
with precision short adapter for meaningful
results.

Smith Chart

Toggle Smith Chart display for selected
complex division FFT or S11 trace.

Layer Peeling

Create layer peeling trace from selected
trace. Assumes active cursor (layer peel
start) is set at 50 ohms.

Hide Selected Trace

Hides the selected trace.

Set Base

Sets selected trace as the base
(denominator) trace for math operations.

Difference

Creates subtraction trace from selected
trace and base trace (Difference = Selected
– Base).

1st Derivative

Creates first derivative trace from selected
trace.
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Table 3.2 (Continued) Math Menu
Menu Selection

Purpose/Action

Der.

Toggles first derivative trace smoothing.

Smooth Off/On

3.9.3. SELECT Button
The SELECT button switches which trace on-screen is the active trace.
See Section 3.11.6 for more information on selected traces.

3.9.4. AUTOFIT/HELP Button
The AUTOFIT/HELP button calls up the online help library, AUTOFIT
soft-menu options, and options for resetting the CT100B’s configurations that
influence trace measurements.
For the help library, use the M-FUNCTION knob and Select menu option to
scroll through and select topics.
When you select the AUTOFIT menu option, the CT100B looks for the TDR
signature of an open or short-terminated cable and selects appropriate horizontal
and vertical scale values to display the entire cable on the screen. By default the
cursors are positioned approximately to the beginning and end of the cable.
If you select Autofit w/o Cursors, the entire cable will be displayed on-screen,
but the cursor position will not be affected.
If Vertical Reset is selected then only vertical scale and position are affected.
Selecting Reset Options brings up four different options for changing the settings
of the CT100B along with brief descriptions of the options (Figure 3.5). You can
reset the basic settings, load a default configuration, load a saved configuration,
or reset all device settings to the factory settings. If the CT100B does not have
saved default or user configurations, those options will be grayed out.

Figure 3.5. The Reset Options menu.
For more information on default and user configurations, see Section 3.11.28.
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The Reset Options menu can also be found by briefly pressing the red POWER
button and choosing Reset Options when the shutdown dialog appears. It is also
part of the CT100B’s startup screens.

3.9.5. CURSOR Button
Toggles between cursors, making the active cursor inactive and the inactive
cursor active. Pressing and holding the CURSOR button for one second then
releasing will reposition any cursors not visible on the screen to the screen.

3.9.6. FILE Button and Menu
Use this menu to access the user library of configurations, cable types, and cable
records. FILE button menu selections are shown in Table 3.3.
Table 3.3. FILE Button and Menu
Menu Selection

Purpose/Action

Custom Cable Types

Use to add, select, or delete an entry from
the custom cable type library:
Enter in new cable type information.
Delete selected cable type from the library.
Select the highlighted custom cable type.
Instrument settings change to reflect the
cable Vp setting.

Add New......................
Delete.......................
Select.......................

Reference Cable Types

Use to select a built-in cable type from the
standard cable type library. Instrument
settings change to reflect the cable Vp
setting.

Cable Scan Records

Use to select, delete, or USB save a
previously saved TDR trace. (See
Section 3.11.8 for more.)

Config Entries

Use to add, select, or delete an entry from
the user configuration library.

Export CSV → USB

Export selected TDR trace as a CSV file to
USB drive.

Save Scan

Saves selected trace to internal storage.

Masks
Create Mask From Trace

Generates mask or test limit based on the
selected trace.

Change Vertical Margin

Adjusts vertical pass/fail criteria of the
mask.

Change Horizontal Margin

Adjusts the horizontal pass/fail criteria of
the mask.

Clear Mask

Removes the current mask from the display.
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Table 3.3 (Continued) File Menu
Menu Selection

Purpose/Action
Use to add, select, or delete a mask from
the mask library.

Masks

Prints directly to a PCL3 compatible
printer via USB.

Print

3.9.7. “Blue” MENU Button and Top-Level Menu
If no menu is displayed, the blue MENU button loads the main top-level menu.
If the top-level menu is displayed, it closes the menu. If a submenu is displayed,
it displays the parent menu. Top-level menu selections are listed below
in Table 3.4. Holding down the MENU button while pressing any button (or the
M-FUNCTION knob) will display a help dialog for that button’s current menu
selection (known as “blue button help”).

Table 3.4. MENU Button and Menus
Menu Selection

Purpose/Action

Cable Len

Adjust the pulse timing for different length
cables:
For cables of up to approximately* 300 ft.
(90 m) long.
For cables up to 1500 ft. (450 m) long.
For cables up to 6,000 ft. (1,800 m) long.
[Note: Access Extra Long mode in the
Measurement submenu. Use Extra Long
mode for cables over a mile (2 km) in
length.]

Short ........................
Medium.......................
Long .........................

*The exact length will depend on the Vp
setting.
Resolution
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Sets TDR trace horizontal sampling
resolution (in picoseconds):
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Table 3.4 (Continued) MENU Button and Menus
Menu Selection
Normal.......................

Screen.......................

Fixed ........................
File (Load/Save)

Purpose/Action
A setting suitable for connector level detail
for each of the cable length modes. Short is
nominally 5.32 ps (< 1 mm). Medium is
nominally 17.5 ps (~2 mm). Long is
nominally 49.6 ps (~1/2 inch). Extra Long
is nominally 381 ps (~2 inches). The actual
setting is dependent on horizontal scale, but
will be at least as good as the nominal
value. If the user adjusts the Horizontal
Scale to zoom in to a very short section of
cable, the resolution setting will
automatically adjust to a finer scale.
Multiple measurements may map to a single
horizontal offset on the display. This allows
you to easily see flaws in the cable or
connectors even when looking at long
sections (see Figure 3.11).
Screen resolution (1 sample/pixel) varies
dynamically with the current horizontal
scale.
Allows user to set a specific value no matter
the cable length setting.
Calls up the FILE button menu. Use it to
add, select, or delete an entry from the
cable type, user configuration, and/or cable
record libraries.

Connect to CT Viewer
Find CT Viewer

Search the local area network looking for
running CT Viewer 2 programs. If
successful, it establishes a connection.

Manual Connect

A dialog with a list of PCs that have
previously been added is displayed.
Enter in new server IP information.
If connected to CT Viewer 2, allows user to
edit PC name.
Delete selected server from the library.
Connect to the highlighted server.
Cancel out of the connection menu.
See Section 4: CT Viewer for instructions
on connecting the CT100B to CT Viewer 2.

Add PC .....................
Edit........................
Delete .....................
Select .....................
Cancel .....................

Use USB

SParam Tools

Go to the PC on which you are running CT
Viewer 2 and use that program to connect
to the CT100B.
Tools for creating S-parameter traces and
normalized traces. See Return Loss (S11 )
Traces in Section 3.11.17.
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Table 3.4 (Continued) MENU Button and Menus
Menu Selection

Purpose/Action

Measurement
Vert.
Vert.

Ref.
Toggles VR (Vertical Reference) mode
on/off.

Ref Off/On

Set Vert.

Performs VR calibration using short/open
terminators. When setup is complete, a
green vertical line indicates start of VR
measurements.

Ref.

Vert.

Ref.

Center Imp.

Adjusts VR calibration to use impedance
matching adapters and baluns.

Vert.

Ref.

Start

Sets start of VR at the position of the
active cursor.

Vert.

Ref.

End

Sets end of VR at the position of the active
cursor.

Cable Segments
Add New Segment

Create a new segment boundary at the
active cursor. The selected segment will be
split in two, each with the same initial Vp.

Delete Segment

Delete the currently selected segment. The
segment will be merged with the segment to
the left.

Delete All Segments

Delete all segments. The CT100B will
return to normal operation. A single Vp
now applies to the entire trace.

Prev Segment

Select the segment to the left of the
currently selected segment.

Next Segment

Select the segment to the right of the
currently selected segment.

Reset All Vp

Reset the Vp of all segments to 1.000.

Restore All Vp

Restore Vp of all segments to the previous
values.

Extra Long Mode
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Extra Long Mode allows the CT100B to
obtain traces out to 40,000 ft. (12,000 m)
(assumes Vp=0.66). Extra Long Mode is
slower than other cable lengths and some
instrument features are not available. When
in Extra Long Mode, the Cable Length
menu option will indicate Extra Long Mode
On. Selecting the cable length menu item
will switch off Extra Long Mode.
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Table 3.4 (Continued) MENU Button and Menus
Menu Selection
Vert.

Units

Envelope Plot

Purpose/Action
Select vertical units for a time-domain trace
from reflection coefficient (mρ), impedance
(Ω) or voltage standing wave ratio (VSWR).
A few features of the CT100B only work
with the reflection coefficient setting.
Captures transient cable and connector
faults.

Envelope Plot Off/On

Enable/disable envelope plot mode. When
turned on the CT100B begins capturing
trace data and displaying envelope plot
information.

Reset

Deletes/restarts captured TDR trace
envelope data.

Fill Mode Off/On

Toggles between fill and probability density
plot mode. Use fill mode to find magnitude
of impedance change and highlighting fault
location. Use probability density plot mode
to find infrequent transient faults.

Hold Off/On

When Hold is on, trace controls are locked
for an envelope plot. When Hold is off,
trace controls work normally.

Clear Historic

As trace controls are used to change an
envelope plot, the envelope plot preserves a
record of the trace from previous positions.
Clear Historic erases this history, leaving
only the plot from the current position.

(Horizontal Units)
Meas.

Toggles through horizontal units (meters,
inches, feet, yards, centimeters)

Settings

Horiz.

Units

Toggles through horizontal units (meters,
inches, feet, yards, centimeters)

RRC Classic/1502C Mode

Classic: Referenced to amplitude at inactive
cursor.
1502C: Referenced to amplitude at test
port.

Vp 3/6 Sig Figs

Toggle Vp significant digits from 3 to 6
digits.

Vert.

Select vertical units for a time-domain trace
from reflection coefficient (mρ), impedance
(Ω) or voltage standing wave ratio (VSWR).
A few features of the CT100B only work
with the reflection coefficient setting.

Units

Vertical Correction
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Table 3.4 (Continued) MENU Button and Menus
Menu Selection

Purpose/Action

Adjust mρ Offset

Allows manual vertical measurement offset
adjustments. This allows advanced users to
manually calibrate impedance
measurements at a particular location to a
known value.
When activated the M-FUNCTION knob
adjusts the vertical offset. The blue
M-FUNC indicator shows the offset in mρ
(millirho).

Cancel mρ Offset

Use this option to cancel a manual mρ
(millirho) correction. Automatic
temperature adjustment will resume
auto-correction of the vertical
measurements.

Adjust Ω/(unit)

Use the M-FUNCTION knob to change the
ohms per unit distance resistive loss setting
until the cable shows no upward or
downward trend across its length.

Ω/(unit) Correct.
On/Off

Toggle resistive cable loss correction on/off,
as described above. If the end point of the
correction has not been set, then it will be
set to the position of the active cursor.

Set Ω/(unit) Pos.

Set the position of the ohms/(unit distance)
position to that of the active cursor.
Reset all Ω/(unit) settings.

Clear

See Table 3.2: Math Menu.

Math
Settings
Meas.

See Meas. Settings under Measurement
menu above.

Settings

Network Settings
Static Network Settings
IP Address . . . . . . . . . . . . . . .
Netmask . . . . . . . . . . . . . . . . . .
Gateway (optional) . . . . . .
Nameserver 1 and 2
(optional) . . . . . . . . . . . . . . . . . . . .
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Modify static network settings (if DHCP
inactive):
IP address (xxx.xxx.xxx.xxx)
Subnet for CT100B
Gateway server setting
Nameserver settings

DHCP on/off

Toggles DHCP on/off.

Show IP Config.

Displays current Ethernet configuration.
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Table 3.4 (Continued) MENU Button and Menus
Menu Selection

Purpose/Action

Web Server On/Off

Toggles the internal web server on and off.
The web server provides .csv format files,
screen capture bitmaps, and the ability to
remotely access the device. See
Section 3.11.24 for more details on accessing
data using web export. [Note: See
Section 4 for more information on using
CT Viewer 2 to acquire TDR traces. See
www. mohrtm. com for information on the
CT100B Python programming library and
binary programming protocol for Ethernet
CT100B interface.]

Selected .csv Options

Opens a dialog for adding additional data
columns in the .csv trace export file.

Set Listen Ports

This dialog box allows you to define a
different RPC port # and a different
Remote Control Port # for use with the CT
Viewer 2 application (default 12347)

SP232 Protocol On / Off

Toggles SP232 emulation on/off. A USB to
serial adapter is required for SP232
emulation. Press this button while
emulation is on to switch the baud rate.

Power
DC Power Save

Sets the inactivity timeout for power save
mode while the device is running on
external DC supply.

DC Shutdown

Sets the inactivity timeout for shutdown
while the device is running on external DC
supply.

Battery Power Save

Sets the inactivity timeout for power save
mode while the device is running on
batteries.

Battery Shutdown

Sets the inactivity timeout for shutdown
while the device is running on battery.

Battery Icon

Toggles battery icon display on/off.

Power Display

Toggles the on-screen power status display
on/off.

Diagnostics
Analog

Run automated diagnostics on the analog
trace acquisition circuit board. Results are
displayed on-screen in a message box.
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Table 3.4 (Continued) MENU Button and Menus
Menu Selection

Purpose/Action

Database

Clean Database: CAUTION! Not for
routine use. This option defragments the
database, freeing up unused space, then
turns off the CT100B. Use this option only
when the CT100B is plugged into an
external power supply. Do not shutdown
the CT100B while the Clean Database
command is in progress.

Front Panel Check

This item opens the front panel button and
knob check screen. Hit each button once
and turn every knob in each direction. Press
the red power button to exit when finished.

Jitter

Jitter measures signal noise, jitter, rise time,
and sampling efficiency of the trace. These
values are used as part of the calibration
checkout for the CT100B, and results of
interest are explained in Appendix B:
Operating Performance Checks.

Calibration

Performs vertical and horizontal calibration.

Info
License
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License Info

This option gives information about the
license installed on the CT100B.

License from USB

Use this option to load a license code from a
USB flash drive.

Enter License

Manually load a license code. This is useful
for operators who are unable to connect to
CT Viewer 2 or use a flash drive.

Web Update

When a CT100B is connected to the
Internet, this item will automatically update
the CT100B if newer software is available.

Update From USB Drive

Will run an update from the connected
USB drive.

Web Update Address

View/set the web address to query for
updated software. Normally this setting
should not be changed.

Processor

Displays CPU information.

Contact

Contact information for MOHR.

Auto Update On/Off

Toggles Auto-Update on/off. With
Auto-Update on, the CT100B will
automatically check to see if it is running
the current software version and notify the
user if a new version exists.
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Table 3.4 (Continued) MENU Button and Menus
Menu Selection

Purpose/Action

Software Version

Display software and firmware version
information. This also serves to verify the
communications links between the
micro-controllers.

Hardware Info

Display hardware information.

Usage

Display instrument usage in hours.

Time

Time and date settings:

Time Date

Set the current date and time.

Set Time Zone

Change the time zone.

Daylight Savings On Off

Sets adjustment for daylight savings time
on/off.

Display
Change Screen Profile

Toggles screen background (black, gray,
white).

Ohms/Rho

Toggles display of impedance (ohms) and
reflection coefficient (millirho) at cursor and
between cursors.

VSWR

Toggles display of VSWR (voltage standing
wave ratio) at cursor.

Trace Labels On/Off

Toggles display of the trace labels directly
below the traces.

Time/Date

Toggles time/date display.

Distance/ns

Toggles display of distance and time (ns) at
cursor.

Temp Comp

Toggles display of Temp Comp
autocalibration status.

Min/Max Display

Toggles display of min/max values for high
resolution sampling.

Horiz.

Toggles display of horizontal and vertical
rulers.

Vert.

Ruler

Noise Value

Toggles display of noise value at cursor for
diagnostic purposes.

Vert.

Toggles the Vertical Shift Correction option.
When on, corrects the vertical shift that can
happen when changing the DUT.

Shift Correction

Time of Flight

Show Time of Flight time measurements.
The standard nanoseconds display shows
electrical time for a pulse to reach a point
and then return to the CT100B.
Time of Flight is exactly half that value. It
is the one-way transmission time.
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Table 3.4 (Continued) MENU Button and Menus
Menu Selection

Purpose/Action

Vert Centering On/Off

When on, changes to vertical scale will
center on the point where the cursor
intersects the selected trace.
When off, changes to vertical scale will
center on the center of the screen.

Draw Internal Cable Bkgnd

Changes the background of the trace
beginning from the start of the trace to the
end of the internal cable.

Auto Smooth Reset On Off

When on the CT100B will automatically
reset smoothing when a change in load is
detected by the device.

Scale

Toggles display of horizontal, vertical scales,
and Vp.

Intersection

Toggles display of cursor-trace intersection.

Decibels

Toggles display of decibel (dB) values at
cursor.

Temperature

Toggles display of instrument internal
temperatures.
When on, the CT100B will automatically
pick a smoothing value based on the
observed noise.
When off, the CT100B will use the
user-entered smoothed value.

AutoSmooth On Off

3.10. Test Preparations
If you would like a detailed explanation of TDR measurement theory and
applications before using the CT100B to test cables, please read Section 5, TDR
Measurement Theory, or go to www.mohrtm.com.

3.10.1. Connecting to the Cable or Device-Under-Test (DUT)
The first and most important decision to make when testing a cable or
device-under-test (DUT) is how to connect to the DUT. Because the connection
to the DUT acts as a filter for the test signal into and out of the DUT, it is very
important that the connection have the highest bandwidth and least aberration
possible.
Controlled impedance connections are recommended whenever possible.
Controlled impedance connections have conductors with uniform geometry and
dielectric properties that do not change significantly during a test session or
between test sessions. Examples of controlled impedance connections include
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coaxial-coaxial adapters, coaxial-twisted pair adapters, and fixed-pitch TDR
probes.
Alligator clip and clip lead adapters with flexible wire test leads should be used
only as a last resort. Alligator clip and clip lead adapters are not made for high
frequency operation, are severely bandwidth limiting, and introduce severe
aberration and measurement uncertainty into the TDR trace. Figure 3.6 shows a
comparison test of a coaxial cable using clip lead adapters (red, top) and a
controlled-impedance adapter (black, bottom). The clip lead adapter TDR trace
is severely degraded.
MOHR is able to supply controlled-impedance adapters for almost every type of
cable and connector.

Figure 3.6. Clip lead adapter (red, top) and controlled-impedance adapter
(black, bottom) testing of 3 ft. coaxial cable with short termination. Active
cursor is at the test port. Clip lead adapters introduce severe TDR trace
distortion.

3.10.2. Change Velocity of Propagation (Vp)
Vp is expressed as a fraction of the speed of light. The current setting for Vp
appears on the lower center of the screen. Press the M-FUNC button until the
top-center information indicator reads “Vp”. If Vp 6 Sig. Figs is enabled from
the Settings → Meas. Settings menu, two separate “Vp” indicators can be
chosen using the M-FUNC button. Coarse Adj. Vp allows for the modification
of the first 3 significant digits and Fine Adj. Vp allows for the modification of
the last 3 significant digits. See Section 5.4 Velocity of Propagation (VoP, Vp)
for a detailed description of Vp.
Turn the M-FUNCTION knob and the Vp value will change accordingly.
Measurements and traces are automatically updated on the display to reflect the
new Vp.
All measurements done by the CT100B are based on time, and then converted
to distance for display. An accurate Vp is necessary for accurate cable length
and Distance-to-Fault calculations. For cables of a known type, the Vp can be
approximated by using the nominal Vp for that cable type. The CT100B has a
built-in library of cable types and their Vp values (see Section 3.11.26). You can
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also measure the Vp by testing a known length of cable that is of the same type
as the one you want to test. The method is described in the following section.

3.10.3. Find an Unknown Velocity of Propagation (Vp)
This method is used to find the Vp for cables under test where the Vp is
unknown. It requires a sample cable that is of the same type that can be
measured physically.
1. Measure the physical length of the test cable. Make sure the test cable is
of the same type for which you need to find Vp. The accuracy of the Vp is
dictated by the accuracy of the physical measurement. If the cables are
terminated, they can be included in the measurement to find a combined
Vp. The physical length measurement should not include any adapters
necessary for connecting the cable to the CT100B.
2. Attach the test cable to the CT100B. For this example, the test cable is
3.0 feet long.
3. Press the AUTOFIT/HELP button, then select the AUTOFIT menu
item. The CT100B will display a trace that includes the beginning and the
end of the test cable. The cursors will be moved to an area approximate to
the cable ends. Figure 3.7 shows an AUTOFIT result. The cable end, in
this case an open termination, has been found at 3.023 feet and the whole
cable trace is displayed on the screen.

Figure 3.7. Screenshot showing AUTOFIT result.
4. Accurately position the cursors to bracket the area of the trace associated
with the test cable. Using the scale and position knobs, move the ending
cursor so that it is just aligned with the “toe” of the open or shorted fault
at the end of the cable (Figure 3.8). If an adapter is used, position the
starting cursor at the end of the adapter. The accuracy of cursor
placement affects the accuracy of the Vp measurement.
5. Press the M-FUNC button to set the M-FUNCTION to Vp, and adjust
Vp using the M-FUNCTION knob until the CT100B distance
measurement to the active cursor equals the physical measurement. The
final Vp value is the true Vp value of the cable (Figure 3.9). Note that in
the Measurement → Meas. Settings menu there is an option to set Vp to
six significant digits.
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Figure 3.8. Use of the HORIZONTAL SCALE knob to improve Vp
accuracy.

Figure 3.9. Final Vp of the cable.
The cable Vp can be saved to a table of custom Vp values. See Section 3.11.26.

3.10.4. Smooth Settings
The CT100B smoothing feature performs temporal averaging to decrease visible
noise on the live TDR trace and improve signal-to-noise ratio (SNR) for first
derivative, S11 return loss, and other mathematical operations. When you
acquire baseline TDR scans of cable assemblies meant for archiving and future
comparison use, it is recommended that at least a moderate level of smoothing
be used so that the vertical resolution of the instrument be used to the fullest
extent possible. The effect of smoothing is most apparent at very small vertical
scale settings (that is, when the trace is zoomed-in vertically). To change TDR
trace smoothing:
1. Press the M-FUNC button until “Smooth” shows up in the upper middle
of the screen.
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2. Rotate the M-FUNCTION knob until the desired level of trace smoothing
is obtained.
A comparison of a smoothed (1,024 trace average) TDR trace to an unsmoothed
TDR trace at 0.7mρ (millirho) per vertical division is shown in Figure 3.10.

Figure 3.10. Smoothed vs. unsmoothed traces at very small vertical scales
(0.7mρ per vertical division).

3.10.5. Sample Resolution
The sample resolution setting establishes the number of sample points per unit
time or distance in the live TDR trace. In general, higher sample resolution
sharpens traces at larger horizontal scales by increasing the effective sampling
efficiency of the TDR trace (the ratio of sampled vs actual change in voltage
from sample to sample). For larger horizontal scales it also helps ensure that all
cable faults are sampled adequately enough to be detected and displayed on the
instrument screen. Note that the sample resolution of cable scans can be set
separately (see Section 3.11.5). The following TDR trace sample resolution
settings are available in the MENU → Resolution menu option:
1. Screen: Screen resolution (1 sample/pixel). Fastest trace, adequate for
many routine cable testing tasks. At large horizontal scales, the resolution
is low and small faults may be undetectable, or at least underestimated.
This is because there may be too few samples in the region of the fault for
the fault to be reliably identified on the trace. For example, if a thousand
foot cable is displayed on the screen, there is only one measurement about
every two feet.
2. Normal: Sample resolution setting is chosen to match the cable length
setting for good compromise of detail and speed. For SHORT length cable
settings, the maximum resolution is 5.34 ps (less than a millimeter). For
MEDIUM length, the maximum resolution is 17.5 ps (about 2 mm). For
LONG length, the maximum resolution is 49.6 ps (about 5 mm). As you
zoom in, the CT100B will adjust resolution.
3. Fixed: Set a sample resolution manually using M-FUNCTION knob; it
stays fixed regardless of screen horizontal scale. Useful for enhancing
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frequency resolution of S11 return loss and cable loss traces which may
require sampling at resolutions higher than Normal mode.
Using fine resolution may result in the CT100B buffering. The CT100B will
show a green circle buffering symbol on-screen until buffering is completed.
For larger horizontal scales, the Normal or Fixed sample resolutions provide
high resolution sampling. The trace display at each pixel is a vertical bar that
shows the maximum and minimum values sampled within the pixel. This
feature ensures that any detectable TDR cable fault is displayed at
least 1 pixel wide regardless of horizontal scale.
A Normal sample resolution trace of an 800 ft. (250 m) cable is shown
in Figure 3.11. In this case the high resolution sampling of the Normal setting
ensures that the small fault from a 50 ohm BNC barrel connector is displayed
despite the large horizontal scale. To see this flaw using only the older Screen
sample resolution mode would require the user to “zoom-in” to show the detail
of a short section of cable, and then to manually scroll the length of the cable
using the HORIZONTAL POSITION knob.

Figure 3.11. A small fault in a long cable. This fault (red circle) in an
approximately 800 ft (250 m) cable is from a 3 cm barrel connector (0.01%
of cable length). The sampling of the Normal sample resolution setting
ensures that the cable fault is displayed at this large horizontal scale (~50
cm/pixel).

3.10.6. Temperature Correction
The CT100B automatically adjusts for changes in ambient temperature. When
temperature is displayed on the screen with Temp Comp toggled on, a message
is shown giving the status of temperature correction. When the CT100B is fully
adjusted, the message reads “TC: OK” in green text.
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3.11. Test Procedures
3.11.1. Measure Distance-to-Fault (DTF)
1. Attach the cable to the test port.
2. Set Vp to match the Vp of the attached cable or select an appropriate
cable from the cable type library. See Section 3.11.26 Cable Type Library
for instructions on using the cable type library.
3. Press the AUTOFIT/HELP → AUTOFIT menu option. The CT100B
trace is now scaled to show the entire cable from beginning to end.
See Figure 3.12.

Figure 3.12. AUTOFIT cable. The cable termination is a short.
4. Note the “bump” in the middle of the cable. This is where two short test
cables are connected with a BNC barrel connector. Position the active
cursor on the reflection caused by this cable fault. Adjusting the vertical
scale helps make cable faults more obvious, as in Figure 3.13 which is at
the same horizontal scale as Figure 3.12 but zoomed-in vertically. By
positioning the inactive cursor just before the connector, we can see the
delta value of ~4.4Ω impedance change in the connector vs. the impedance
of the cable.
5. Use the HORIZONTAL SCALE and VERTICAL SCALE knobs to
further zoom in on the fault to get a more accurate measurement of
Distance-to-Fault (DTF). Position the cursor at the “toe” or early rising
edge of the fault. The distance measurement shown on the screen for the
active cursor is then the Distance-to-Fault. See Figure 3.14.

3.11.2. Relative Distance and DTF Measurements
The CT100B displays the absolute distance from cable start and also the
relative distance from the inactive cursor to the active cursor. Note that Vp
must be set accurately for the section of cable between the cursors for the
CT100B to measure relative Distance-to-Fault accurately. The pulse velocity of
any part of the cable that is not between the cursors will not affect the relative
distance measurement. To measure the relative distance between two points in a
cable, do the following:

36

CT100B TDR Cable Analyzers Operator’s Manual

3. Operating Instructions

Figure 3.13. Vertical scale used to emphasize cable fault.

Figure 3.14. A horizontally zoomed-in view of the cable fault with active
(solid) cursor at the start of the fault (“toe” region) and inactive (dashed)
cursor at the peak of the fault. The DTF measurement is highlighted (red
circle).
1.
2.
3.
4.

Move the active cursor to the beginning of the section to be measured.
Press the CURSOR button to switch cursors.
Move the newly active cursor to the end of the section to be measured.
The CT100B displays the distance measured between the two cursors as a
“∆” value below the absolute distance measurement. Figure 3.15 is a 3 ft.
segment of 50 ohm cable marked by small impedance “faults” caused by
BNC connectors on both ends.

In general for the most accurate relative distance or time measurements between
two faults, place the cursors on the “toe” region of the faults where the TDR
trace is just beginning to rise above or fall below the cable characteristic
impedance.
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Figure 3.15. Relative distance measurement between two small impedance
“faults” caused by BNC connectors.

3.11.3. Multi-Segment Cable DTF Measurements
Cable assemblies are sometimes made up from different types of cables in series,
each of which may be chosen for unique characteristics such as high-temperature
operation or radiation resistance. Such cables frequently have different velocities
of propagation (Vp), making Distance-to-Fault (DTF) measurements difficult. If
the average Vp of the assembly or the Vp of any one cable assembly is used, it
will result in inaccurate distance measurements along the length of the
compound cable.
The CT100B includes multi-segment cable measurement capability designed to
improve cable measurement accuracy in the setting of compound, multi-segment
cables with differing Vp values. The CT100B allows the operator to break a
TDR trace into cable segments, each of which can have its own Vp. The
distance-to-fault calculated from the compound trace shows improved accuracy.
The following procedure can be used to perform multi-segment cable
measurements:
1. Select MENU → Measurement menu.
2. Select Cable Segments submenu.
3. Place the cursor at the position of the cable segment, marked by a
connector impedance signature or other demarcation, such as physical
distance as calculated using known Vp for a given cable segment.
4. Select Add New Segment.
5. Repeat steps 3 and 4 for each cable segment.
6. Use the Prev Segment and Next Segment selections to select each cable
segment and use the M-FUNC Vp option to set the given segment’s
velocity of propagation.
7. The Distance-to-Fault measured by the cursor reflects multi-segment Vp as
shown in Figure 3.16 and Figure 3.17.

38

CT100B TDR Cable Analyzers Operator’s Manual

3. Operating Instructions

Figure 3.16. Multi-segment cable segment with Vp of 0.400 (red circle).

Figure 3.17. Multi-segment cable segment with Vp of 0.850 (red circle).

3.11.4. Ohms-at-Cursor Measurements
The CT100B also displays the impedance in ohms (Ω) at the cursor position. A
reading before and after a reflection from a fault shows the impedance mismatch
that could cause such a reflection. Impedance measurements at the first fault in
a cable are more accurate than impedance measurements at more distant
faults.

3.11.5. Scan a Cable
The CT100B can scan and save a trace into memory. CT100B scans differ from
traditional TDR traces because they can be used to save detail at a much higher
resolution than displayed on the screen. Cable scans can subsequently be
reviewed at different levels of detail and compared to prior scans to identify
subtle changes in cable or connector performance. See Figure 3.18 and
Figure 3.19. Scans may also be referred to as traces in this manual.
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Figure 3.18. Scan progress display with Cancel button.

Figure 3.19. Scan of a portion of a cable (red), zoomed-in vertically to
show additional detail relative to the live trace (black).
Saved scans can appear on the screen in addition to the live trace. Pressing the
SELECT button switches between traces. Vertical position and scale are
adjusted for individual traces. Changing these values for one trace won’t affect
other traces.
To scan a cable or cable segment:
1.
2.
3.
4.

Press the SCAN button to bring up the Scan menu.
Select Snapshot or Cursor.
Choose the Start Scan option from the menu to begin a cable scan.
Select the cable scan (see Section 3.11.6 below) and manipulate as needed.

There are two types of scans:
1. Snapshot scan - Capture the live trace as it appears on the screen. This
can work well if using Normal or Fixed resolution mode. If using Screen
resolution, the result may be less detailed.
2. Cursor scan - Captures the entire trace between the two cursors using the
current sample resolution (see Section 3.10.5). This works even if one or
both cursors are off-screen when you begin the scan.
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A scanned trace is created using the smoothing factor that is set at the time of
the scan. Because of this, high resolution or highly smoothed scans may take a
long time. During a scan, a menu will appear with a Cancel option. Select
Cancel to abort the scan.

3.11.6. Select a Trace
The CT100B always shows one trace on the screen in bold. This is the selected
trace. If it is a live trace, the VERTICAL POSITION and VERTICAL SCALE
knobs can be used on the selected trace, leaving other traces on the screen
unchanged. If the selected trace is not a live trace, you can also use the Save,
Rename, and Hide Selected Trace options on the Scan menu without affecting
other on-screen traces. Vertical measurements such as reflection coefficient,
return loss, and impedance are always based off of the selected trace and may
disappear if the cursor scrolls beyond a scanned boundary or is off screen.
Press the SELECT button to change which trace is active. Figure 3.20 shows a
screen with three traces and the LIVE TRACE is selected.

Figure 3.20. Selecting the live trace.
Figure 3.21 shows the same three traces with a saved scan selected. The saved
trace has been moved vertically using the VERTICAL POSITION knob so that
it is easier to see.
Figure 3.22 shows the same three traces but now the trace representing the
difference between the two is selected.

3.11.7. Store a Trace
A scanned trace can be stored for later recall:
1.
2.
3.
4.

Press the SCAN button. The Scan menu appears.
Press the SELECT button until the scanned trace to be stored is selected.
Select the Save option from the menu.
The CT100B requires a name for storage and will prompt for one with a
dialog box.
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Figure 3.21. Selecting a scanned trace.

Figure 3.22. Selecting a difference trace.
5. A dialog menu appears. Press the Show Keyboard menu option to display
the on-screen keyboard or use a USB keyboard.
6. When using the on-screen keyboard use the M-FUNCTION knob to
highlight characters. See Figure 3.23. Review Section 3.7.2 for more
information on using the Keyboard menu. Press the Select Highlighted
option to enter the highlighted letter into the name.
7. Press the OK option from the menu when finished.
The trace is now stored, and can be recalled later by name under FILE → Cable
Scan Records. Other trace types, such as difference traces, derivative traces, and
frequency domain traces (such as FFTs) can also be stored with the same
process.

3.11.8. Load a Trace (Cable Records)
A stored trace can be loaded back to the screen:
1. Press the FILE button. The File menu appears.
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Figure 3.23. Using the on-screen keyboard. Choose Hide Keyboard when
finished. Then choose OK to save the trace with the name you entered.
2. Select the Cable Scan Records option. A scrolling dialog box (see 3.7.2.1)
appears for the selection of a stored trace.
3. Use the M-FUNCTION knob to highlight the trace you wish to load.
4. Press the Select menu option to load the trace.
The stored trace now appears on the screen. It can be selected and manipulated
the same as any scanned trace. See Figure 3.24 in which the loaded trace (red,
top) has been translated slightly upward using the VERTICAL POSITION
knob in order to improve visualization. Some stored traces, such as FFT traces,
require some re-calculation to fully load. This calculation is done automatically,
but it may take several seconds.

3.11.9. Storing, Transferring, and Deleting Traces
The CT100B has a large storage space, capable of holding thousands of trace
scans. However, with continued use, CT100B storage will eventually fill up.
Periodically, an effort should be made to clear stored traces from the device and
free up storage space.
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Figure 3.24. Loading a trace.
3.11.9.1. Transferring Traces
The CT100B ships with an installation DVD for the CT Viewer™ (Version 2)
software for Windows. Using either a USB or an Ethernet connection, the
CT100B can transfer stored scans to CT Viewer 2. These scans are then stored
in the Windows computer for later retrieval, review, email, and analysis. See
Section 4: CT Viewer™ and/or the CT Viewer™ 2 Quick User Guide for
details on transferring traces to a computer using CT Viewer 2.
3.11.9.1.1. Export Trace to File Traces can also be exported to a USB drive for
storage, or to transfer to CT Viewer 2 or to another CT100B. To export one or
more traces to USB:
1. Insert a USB drive into the front panel of the CT100B.
2. Press the FILE button, and then press the Cable Scan Records menu
option.
3. Mark specific traces for transfer using the Toggle Selected option or select
them all with the Mark All option.
4. Press the Export → USB menu option. A message should appear after a
short time confirming that the traces were transferred.
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3.11.9.1.2. Export Trace to CSV The active trace can be exported to a .csv file
on an attached thumb drive. To do this:
1. Select the desired trace to export using the SELECT button.
2. Press the FILE button to open the file menu.
3. Press the Export → CSV menu option. A dialog box will appear
displaying the name of the file to be used.
4. Change the file name to the desired name using a USB keyboard or the
on-screen keyboard by pressing the Keyboard menu option.
5. Press the OK menu option. A message should appear after a short time
that confirms the trace was exported.
3.11.9.2. Deleting Traces
Once scans are backed up to a computer, they can be deleted from the CT100B
either through the CT Viewer 2 software or directly as follows:
1. Press the FILE button to open the File menu.
2. Select Cable Scan Records. A scroll dialog appears, showing all saved trace
scans.
3. Mark specific traces for deletion using the Toggle Selected option or select
them all with the Mark All option.
4. Select the Delete option. You will have to confirm the deletion.

3.11.10. Mask Testing
The CT100B is capable of performing mask testing on the currently displayed
live TDR trace. The mask creates an area around the scanned trace that
functions as a test limit for the live TDR trace. Any point of the trace that
extends into the masked area will cause the background to turn red. This can be
used for creating acceptance criteria for cable segments and connectors. See
Figure 3.25 and Figure 3.26 for examples of traces passing and failing a mask
test.

Figure 3.25. A trace that passes the mask test
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Figure 3.26. A trace that fails the mask test
To create a Mask, use the following procedure:
1. Make sure your vertical units are set to millirho (mρ). Go to MENU →
Measurement → Vert. Units to change your vertical units, if necessary.
2. Create a cable scan or load a scan from memory that will be used to
generate a mask.
3. Select FILE → Masks menu.
4. With the desired cable scan selected, select Create Mask from Trace.
5. The CT100B will generate a mask using the selected cable scan and
display it on the screen. If the live TDR trace fits within the mask, it will
appear with a green background.
6. Use Change Vertical Margin and Change Horizontal Margin to adjust the
mask boundaries around the trace.
3.11.10.1. Storing a Mask
The CT100B is capable of storing thousands of masks. To do this:
1. With a mask already displayed select FILE → Masks menu.
2. Select Masks. This will open a dialog for saving, exporting, loading, and
deleting masks.
3. Select Add New.
4. The CT100B requires a name for storage and will prompt for one with a
dialog box.
5. A dialog menu appears. Press the Keyboard menu option to display the
on-screen keyboard, or use a USB keyboard.
6. When using the on-screen keyboard, use the M-FUNCTION knob to
highlight characters. See Figure 3.23 for more information on using the
Keyboard menu. Press the Select Highlighted option to enter the
highlighted letter into the name. Press Hide Keyboard to accept the name.
7. Press the OK menu option when finished.
The mask is now stored and can be recalled later by name under FILE →
Masks → Masks.
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3.11.10.2. Loading a Mask
To load a saved mask from storage, use the following process:
1.
2.
3.
4.
5.

Press the FILE button. The File menu appears.
Press the Masks option to enter into the Masks menu.
Press the Masks option again to enter into the mask storage dialog.
Use the M-FUNCTION knob to highlight the mask you wish to load.
Press the Select menu option to load the mask.

The stored mask will now appear on-screen after a brief loading time.
3.11.10.3. Exporting/Importing a Mask
Masks can be exported to and imported from a USB drive in order to replicate
mask testing on multiple CT100Bs. Exporting can be done by:
1. Press the FILE button. The File menu appears.
2. Press the Masks option to enter into the Masks menu.
3. Select Masks option again. A scroll dialog appears, showing all saved
masks.
4. Use the M-FUNCTION knob to highlight the trace you wish to export.
5. Press the Export → USB option.
6. The mask will be copied to the USB drive.
To import a mask to the CT100B, do the following:
1. Press the FILE button. The File menu appears.
2. Press the Masks option to enter into the Masks menu.
3. Select Masks option again. A scroll dialog appears, showing all saved
masks.
4. Use the M-FUNCTION knob to highlight BROWSE USB.
5. Press the Select option. This will navigate to the attached USB drive.
6. Use the M-FUNCTION knob to highlight the mask to be imported.
7. Press the Import → Internal option.
8. The mask will be copied to internal storage of the CT100B.
3.11.10.4. Deleting a Mask
Once masks are backed up to a computer, they can be deleted from the CT100B
as follows:
1. Press the FILE button to open the File menu.
2. Press the Masks option to enter into the Masks menu.
3. Select Masks option again. A scroll dialog appears, showing all saved
masks.
4. Mark specific masks for deletion using the Toggle Selected option or select
them all with the Mark All option.
5. Select the Delete option. You will have to confirm the deletion.
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3.11.11. Envelope Plot (Transient/Intermittent Fault Detection)
Cable system troubleshooting frequently involves detecting and localizing
transient or intermittent faults, such as a twisted pair cable with frayed
insulation that briefly shorts its conductors when mechanically disturbed, or a
coaxial connector that reflects an open when shaken. The CT100B’s Envelope
Plot mode simplifies characterization of these types of intermittent faults. To
create an Envelope Plot, use the following procedure:
1. Position the TDR trace such that the area of interest is located on the
screen at a satisfactory horizontal and vertical scale. Resolution from
previous measurement will be preserved.
2. Select MENU →Measurement menu.
3. Select Envelope Plot submenu.
4. Select Envelope Plot Off to turn Envelope Plot mode on.
5. Use the Fill Mode On/Off option to toggle between Fill Mode and
Probability Density display mode.
6. The CT100B can monitor a trace for extended periods of time with
appropriate power management settings are enabled.
7. Sometimes manipulation of the cable and/or connectors of interest during
Envelope Plot monitoring will provoke an intermittent TDR fault.
Fill Mode fills in an area plot between the maximum and minimum impedance
values. This is useful to highlight the location of the fault because the fault
typically creates an “arrow” that points to the location of the fault as shown
in Figure 3.27.

Figure 3.27. Envelope Plot with Fill Mode, with the active cursor
positioned at the fault location (red circle). Note that the black lines shown
here to emphasize the “virtual arrow” do not actually appear on the
instrument screen.
Probability Density mode shows the underlying TDR traces which can be useful
to determine the fault mechanism and likelihood of occurrence as shown
in Figure 3.28. Both modes provide the range of impedance values at cursor, as
shown in Figure 3.29.
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Figure 3.28. Envelope Plot with Probability Density display.

Figure 3.29. Envelope Plot with Fill Mode, showing the range of
impedance values at the cursor position (51.5–185.4 ohms, red circle)

3.11.12. Difference (Subtraction) Traces
Difference traces are traces calculated from the subtraction of one trace from
another trace. A difference trace can allow the operator to identify subtle
changes in cable or connector performance. It is recommended that for any
important cable and connector assembly, the as-manufactured or known-good
configuration of the assembly be scanned and archived on the CT100B and/or a
host PC running CT Viewer 2. Later, these archived traces can be used to
create difference traces from current data to highlight changes in cable assembly
impedance. To create a difference trace, use the following procedure:
1. Press the SCAN button. The Scan menu appears.
2. Press the SELECT button until the first trace of interest is selected.
3. Select the Math option from the Scan menu and choose Set Base. The
selected trace will turn purple and is now a base trace for further Math
functions.
4. Press the SELECT button again until the second trace is selected.

CT100B TDR Cable Analyzers Operator’s Manual

49

3. Operating Instructions
5. Select Difference from the Math menu. A new trace is created that
displays the difference between the base trace and the selected trace.
See Figure 3.30, which shows 3.43 ohm excess impedance due to a slightly
loosened BNC barrel adapter. The bottom bold trace is created by
subtracting the top (live) trace from the middle (scanned) trace and
adjusting the vertical scale to emphasize trace detail.

Figure 3.30. Difference trace. Live (base trace, purple, top), comparison
scan (red, middle), difference (blue, bottom) traces show 3.43 ohm excess
impedance (red circle) on the live trace due to a loosened BNC connector.

3.11.13. First Derivative (Slope) Traces
The first derivative trace can be used for two main purposes. First, the first
derivative trace can be used to emulate the trace of a pulse-type TDR. Second,
it may be used to remove the baseline deviation of long or lossy cables caused by
resistive loss, so that vertical gain can be used to emphasize cable faults. To
create a first derivative trace, use the following procedure.
1.
2.
3.
4.
5.

Press the SCAN button. The Scan menu appears.
Press the SELECT button until the trace of interest is selected.
Select the Math option from the Scan menu. The Math menu will appear.
Select 1st Derivative from the menu.
A new trace is created that displays the first derivative of the base trace.
See Figure 3.31.

3.11.14. Second and Higher Order Derivative Traces
The 1st Derivative function can be applied to First Derivative traces to create
second (and higher) order derivatives.

3.11.15. Vertical Reference (Vert. Ref.) Calibration
Use the vertical reference (Vert. Ref.) system to increase the accuracy of
vertical measurements, including impedance, reflection coefficient, and return
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Figure 3.31. First-derivative trace (yellow, bottom).
loss. The Vert. Ref. feature can be used with a direct connection, through
impedance matching adapters, and using baluns. To calibrate with the Vert.
Ref. feature, use the following procedure:
1. Go to the MENU → Measurement menu.
2. Select the option for Vert. Ref. to display the Vert. Ref. menu.
3. Position the active cursor at the leftmost position where the Vert. Ref.
should apply. Typically, this will be the position where you will apply the
open and short attachments in step five. This position can be changed
after the setup.
4. Select the Set Vert. Ref option.
5. A set of terminators, both open and short, are included with the CT100B
for calibration purposes. Attach these terminators to the CT100B when
prompted to do so (pn: CT100-AC-ISS, CT100-AC-ISMM,
CT100-AC-IBS, CT100-AC-IBMM).
When the reference measurement is finished, cursor measurements will now
appear in blue at the right hand of the screen, and the notification using vert.
ref. will appear underneath.
A green line will appear at the position of the active cursor (see step 3 above).
Vertical reference is applied to all points to the right of the green line. Standard
vertical measurements are used for all points to the left of the green line. The
position of this line can be changed with the Vert. Ref Start menu option.
By default, the impedance value at 0 mρ (millirho) is taken to be 50 Ω. This
value can be changed with the Vert. Ref. Center Imp. menu option. If you are
using an impedance matcher or balun adapter, the center impedance should be
changed to the value of impedance of the adapter. For instance, if you are using
a 100 ohm differential pulse splitter balun to measure differential impedance of
twisted pair cable, then the center impedance should be changed to 100 Ω.
The CT100B is now configured for enhanced accuracy impedance measurements
across a wide range of impedances.
The Vert. Ref. On/Off menu option can be used to toggle the vertical reference
on and off as needed for a given cable length setting.
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3.11.16. Cable Resistive Loss Correction
The CT100B has a system for correcting for resistive loss (“dribble up”) in
cables. This allows the operator to measure impedance more accurately through
long and/or lossy cables.
Under the Measurement menu, there is an item to set ohms per unit length and
another item to toggle the correction on and off. The calculations of this feature
assume a linear serial resistance to an attached cable and no other loss. The
procedure for performing resistive cable loss correction is as follows:
1. Select the MENU → Measurement menu.
2. Select Vertical Correction submenu.
3. Adjust the trace of interest so that it fits on the screen and position the
active cursor to the right of the trace you wish to correct.
4. Select Adjust Ω/ft. (Note: This menu option will show the horizontal
units set in MENU → Settings → Meas. Settings → Horiz. Units [see
Section 3.11.27.1]; i.e., if set to meters, the menu option will read Adjust
Ω/m instead. This is true for all steps in this section.)
5. Select Ω/ft Correct. Off to turn on the correction then press Set Ω/ft Pos.
to set the correction endpoint. The endpoint will appear as a dotted
orange vertical line.
6. Rotate the M-FUNCTION knob to change the ohms per unit distance
correction setting. Use the Ω/ft Correct On toggle menu option to turn
the correction on or off.
Changing the Ohms/m setting will change the slope of the cable’s trace as the
resistive loss is subtracted, and consequently the impedance readings for all
points on the cable’s trace and beyond. The effect and accuracy of the ohms per
unit length value is dependent on the value for pulse velocity. The effect of
resistive cable loss correction on a relatively lossy 72 ohm RG-59 cable is shown
in Figure 3.32 and Figure 3.33.
Use this correction to make more accurate impedance measurements on a length
of cable. Since uniform cables tend to have a characteristic resistive loss per unit
length or “dribble up”, one technique is to adjust the correction until the cable
is as flat as possible. Another technique is to attach a known impedance
reference, such as a resistive terminator, to the cable and adjust the ohms per
unit length correction until the measured impedance reads the correct value.

3.11.17. Return Loss (S11 ) Traces
This feature uses precision open, short, and 50 ohm load (OSL) calibration
standard measurements to correct for systematic errors in the pulsing and
sampling electronics, producing a more accurate S11 result on the Device Under
Test (DUT). The procedure for creating an S11 return loss plot is as follows:
1. Prepare the CT100B by setting the trace resolution as desired by going to
Resolution → Fixed and using the M-FUNCTION knob. In general, a
resolution of 1-2 ps is adequate to take advantage of the full bandwidth
and frequency resolution of the instrument. Larger sample intervals can
result in lower bandwidth resolution. Smaller sample intervals have higher
frequency resolution but increase sampling time.
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Figure 3.32. Resistive cable loss correction, before. Note that the trace
slowly rises.

Figure 3.33. Resistive cable loss correction, after. Note that the trace is
nearly horizontal.
2. Use the M-FUNCTION knob to set the smoothing factor to an acceptable
level, usually in the range of 64 to 256 depending on the application. Use
higher smoothing factors for higher bandwidth, lower noise measurements.
Higher levels of smoothing improve the signal to noise ratio (SNR).
3. With the DUT detached, place the leftmost cursor just to the left of
the test plane (the location where the calibration standards will be
applied). This is usually just to the left of the open at the test port or
alternatively at the end of the phase stable cable.
4. Attach the DUT to determine the region of interest and place the
rightmost cursor just to the right of the region of interest. This is usually
where steady state TDR trace amplitude has been restored. Detach the
DUT to continue calibration.
5. Select the SCAN → Math menu option to open the Math menu.
6. Select SParam & Normalize Tools. This will open the SParam &
Normalize Tools menu.
7. Select S11 Calibration. After going through an informational message box,
the S11 Calibration menu will appear and the CT100B will ask for the
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open terminator. Attach the open terminator and press Scan Open, or
alternatively press Use Selected to use the currently selected trace as the
open calibration standard. For the best results when using type SMA
terminators, use a calibrated 3.5 in-lbs (0.4 Nm) torque wrench (pn:
CT100-TL-TORX7) to tighten the test standards as well as the DUT.
8. Follow the same process as instructed to scan or use the selected trace for
the short and 50 ohm load calibration standards.
9. The instrument will now ask for the Measured “Device Under Test”
(DUT). Press Use Live to create a live S11 trace, Use Selected to create a
static S11 trace from the currently selected trace, or Scan Measured to
scan the current live TDR trace.
10. Select the S11 return loss trace. Use the cursors to measure return loss at
cursor and average return loss between cursors.
Figure 3.34 shows an S11 return loss plot and TDR trace for a 2.4 GHz WiFi
antenna. The return loss at 2.4 GHz (2400 MHz) is 20.9 dB.

Figure 3.34. S11 return loss plot (orange) and TDR trace (red) of a 2.4
GHz WiFi antenna. The return loss is calculated on the portion of the TDR
trace between the cursors

3.11.18. Return Loss (S11 )Options
There are several mathematical transforms to apply to the S11 trace and its
input traces that can, in some cases, help reduce irregularities in the final
Return Loss plot. These options can be found under SCAN → Math → SParam
& Normalize Tools → S11 Options. If the options are changed when no S11
traces exist, then they will be applied to the next S11 trace created. Otherwise,
they are applied to the last S11 trace that was selected using the SELECT
button. The options can be combined as necessary, and will change the last
selected S11 trace in real time.
3.11.18.1. Return Loss (S11 ) Pre-Filter
The Pre-Filter can reduce aberrations in the S11 trace. This can be combined
with a Common Mode Subtraction (CMS) transform on the input traces. To
enable or disable these settings, do the following:
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1. Create an S11 return loss plot using the procedure as described in
Section 3.11.17.
2. Select the S11 Options menu, then Pre-Filter Options.
3. Toggle Use this filter to apply filter to the S11 trace.
4. Toggle Common Mode Subtraction (CMS) to apply this option to the S11
trace.
5. Filter/CMS Offset Ratio is the start of the Aberration Filter and/or
Common Mode Subtraction relative to the S11 trace test plane. The
default value is 1.66, and is ideal in most cases.
6. Frequency (MHz) is the aberration filter frequency. The default value is
200, and is ideal in most cases.
7. Press OK to change the settings to those set above. The S11 trace will
update using the new settings.
3.11.18.2. Return Loss (S11 ) Post-Filter
The Post-Filter can reduce excess noise in the S11 trace. To enable or disable
the setting, do the following:
1. Create an S11 return loss plot using the procedure as described in
Section 3.11.17.
2. Select the S11 Options menu, then Post-Filter Options.
3. Toggle Use this filter to apply filter to the S11 trace.
4. Frequency (MHz) is the noise filter frequency. The default value is 20,000
(20 GHz), and is ideal in most cases.
5. Toggle Apply Hanning to apply a Hanning Window to the filter.
6. Press OK to change the settings to those set above. The S11 trace will
update, although it might not look visually different, depending on the
settings.
3.11.18.3. Return Loss (S11 ) Phase Correction
Phase Corrections reduces phase error oscillation in the S11 trace. To enable or
disable the setting, do the following:
1. Create an S11 return loss plot using the procedure as described in
Section 3.11.17.
2. Select the S11 Options menu, then Phase Corr. Off menu option to toggle
to Phase Corr. On. The S11 trace will update, although it might not look
visually different, depending on the settings.
Phase Correction typically works best when started at the S11 trace test plane.
To choose a different starting point:
3 Use the SELECT button to select a TDR trace, position the active cursor
where desired, then press Phase Corr. Start. The Phase Correction
starting point will go to the active cursor position, and the S11 trace will
update, although it might not look visually different, depending on the
settings.
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3.11.18.4. Time-Domain Gating, or Return Loss (S11 ) Between Cursors
The CT100B is able to use time-domain gating (also called time windowing) to
de-embed features in the time-domain trace for analysis in the frequency domain
using the S11 Between Cursors feature. All other time-domain features are
excluded from the analysis so that only the feature of interest is analyzed. To
perform Between Cursors return loss, use the following procedure:
1. Create an S11 return loss plot using the procedure as described in
Section 3.11.17.
2. Use the SELECT button to select a TDR trace.
3. Position the cursors around the feature of interest (e.g., a fault or
connector).
4. Select the S11 Options menu, then Between Cursors Off menu option to
toggle the S11 Between Cursors feature on. The S11 trace may change to
reflect just the features in the highlighted time-domain cursor interval.
5. Pressing the Between Cursors On menu option again will change it to
Between Cursors Hold, which will keep the time-domain region fixed while
moving the time-domain cursors. Otherwise, you may select the S11 trace
to make frequency-domain measurements using the cursors without
changing the time-domain windowing.
See Figure 3.35 through Figure 3.37 for an example of an S11 return loss plot
between cursors. The cursors bracket an SMA barrel adapter between two 3 ft.
segments of coaxial cable. The S11 return loss plot shows average 34.46 dB loss
across the connector. A loosened connector shows average loss of 26.7 dB across
the connector, compatible with 7.7 dB excess return loss compared with the
tightened connector.

Figure 3.35. S11 between cursors bracketing an SMA barrel adapter on the
TDR trace.

3.11.18.5. Return Loss (S11 ) Calibration Standards
Many precision Open, Short, and Load standards have unique offset and
coefficient values included with them. By correcting the S11 trace with these
values, the error introduced by these terminators can be reduced. To apply or
change these standards, do the following:

56

CT100B TDR Cable Analyzers Operator’s Manual

3. Operating Instructions

Figure 3.36. S11 between cursors with tightened connector showing average
return loss of -34.46 dB from 756 MHz to 3 GHz.

Figure 3.37. S11 between cursors with loosened connector showing average
return loss of -26.7 dB from 756 MHz to 3 GHz (7.7 dB excess return loss
compared with the tightened connector in Figure 3.36).
1. Create an S11 return loss plot using the procedure as described in
Section 3.11.17.
2. Select the S11 Options menu, then Calibration Standards.
3. Toggle Use Calibration Kit Standards to apply offsets and coefficients to
the S11 trace.
4. Set the Characteristic Impedance in Ohms. This is defaulted to 50.
5. Enter the offsets and coefficient values provided with the Open-Short-Load
Calibration Standards. If none are provided, or they are unknown, set
these values to 0.
6. Toggle Restore Defaults to disregard the values set in the table, and to use
those loaded from the CT100B internal storage. If this is checked when
OK is pressed, all former values will be overwritten.
7. Press OK to change the settings to those set above. The S11 trace will
update, although it might not look visually different, depending on the
settings.
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3.11.18.6. Return Loss (S11 ) Other S11 Options
Additional miscellaneous options can be found under SCAN → Math →
SParam & Normalize Tools → S11 Options → Other S11 Options, and then
toggle the options desired.
• OSL Bases Visible: If not checked, the Open, Short, and Load traces will
be hidden after the S11 trace is created. This is to help reduce the visual
clutter of the display.
• Align Base Traces: If checked, and if the input traces to the S11 trace all
include the internal cabling, the input traces are aligned to the common
first rise of the internal cable.

3.11.19. Improving S-Parameter Measurements
Note that testing short microwave cables directly from the test port may cause
unacceptable noise due to the presence of secondary reflections in the TDR
trace. In general, this shows up as excessive spectral noise. In this case, time
windowing can be used to restore measurement accuracy:
1. Attach a 2 ft. phase stable cable to the test port of the instrument.
2. Place the leftmost cursor just to the left of the end of the phase stable
cable.
3. Identify the start of the multiple reflections on the cable under test and
exclude this region with the cursors (see Figure 3.38).

Figure 3.38. Using a phase stable cable to improve S-parameter
measurements on short microwave cables. Use the phase stable cable (green
arrow) and position the rightmost cursor to the left of the secondary
reflections (red circle) occurring after the open or short at the end of cable
under test (blue arrow) so that they are excluded.
4. Perform SParam calibration as described in Section 3.11.17.
The time-windowed trace will have substantially reduced noise due to exclusion
of the secondary reflections.
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3.11.20. Smith Charts
The Smith chart is a useful graphical tool for plotting reflection coefficients and
complex impedance values and can be used to simplify impedance matching.
For a very brief introduction to Smith charts see Section 5.12. The CT100B
allows the operator to display S-parameter return loss and cable loss traces on a
Smith chart. To create a Smith chart, use the following procedure:
1. Create an S11 return loss plot using the procedure as described in
Section 3.11.17.
2. With the S11 trace selected, adjust the cursors to minimum and maximum
frequency desired on the Smith chart.
3. Go to SParam Tools and select the Smith Chart option to toggle Smith
chart display.
4. Use the HORIZONTAL POSITION knob to move the cursor along the
complex impedance curve.
Figures 3.39 - 3.42 show Smith chart representations of an open, short, resistive
50 ohm load, and a reactive 200 ohm load.

Figure 3.39. Smith chart representation of open fault (red arrow).

Figure 3.40. Smith chart representation of short fault (red arrow).
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Figure 3.41. Smith chart representation of a 50 ohm resistive load (red
arrow).

Figure 3.42. Smith chart of reactive 200 ohm load showing effect of
reactive impedance at higher frequencies. Cursor (red arrow) shows
impedance value calculated at DC (0 MHz).

3.11.21. Normalized TDR Traces
This process creates a normalized TDR trace based on a calibrated S11 return
loss trace. A normalized TDR trace appears as another trace in the region of
S11 calibration. The normalized trace should be cleaner than the Measured
DUT trace, with fewer aberrations. The normalized trace also has an adjustable
rise time to help the operator determine what effect a particular cable fault will
have on signals with differing rise times. The following procedure creates a
normalized TDR trace:
1. Create an S11 return loss plot using the procedure as described in
Section 3.11.17.
2. From the SParam & Normalize Tools menu, select Apply Normalization.
3. Select Normalize Pulse Rise Time and use the M-FUNCTION knob to
select a suitable rise time for the cable system as applicable. Note that
selecting a rise significantly shorter than the native rise time of the TDR
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instrument will result in a degraded trace.
4. Note that the S11 Options, such as the Between Cursors On/Off setting is
used by the TDR normalization process. If Between Cursors mode is
turned on, the normalized trace information will be taken from the
time-windowed S11 trace.
Figure 3.43 shows a normalized TDR trace (blue) with a short fault in a 50 ohm
cable. The normalized trace shows reduced aberrations and more accurate
relative reflection coefficient and impedance after the fault compared with the
live TDR trace.

Figure 3.43. Normalized trace (blue, bottom) showing short fault in a 50
ohm cable.

3.11.22. Layer Peeling (Dynamic Deconvolution) Traces
The CT100B includes the capability to perform layer peeling/dynamic
deconvolution. This is a useful technique for improving impedance accuracy by
removing the effects of multiple reflections caused by impedance discontinuities
along the length of the cable. In general, any impedance discontinuity creates
both forward (transmission) and backward (reflection) waves. If reflected off
other impedance discontinuities, these reflected waves will constructively or
destructively interfere along the length of the TDR trace, leading to impedance
measurement errors. The CT100B Layer Peeling feature iteratively extracts the
underlying reflection coefficients as described in Section 5.14. For a more
detailed description of layer peeling, see Section 5.14. To create a layer peeling
trace, use the following procedure:
1. Position the TDR trace on the screen so that the region of interest is
visible with a portion of 50 ohm cable visible at the left hand of the screen
(use the CT100B’s internal 50 ohm cable if needed).
2. Use the HORIZONTAL POSITION knob to place the active cursor on the
50 ohm cable at the left side of the screen. The location of this cursor will
define the start of the left side of the layer peeling trace.
3. Select Math menu.
4. Select Layer Peeling menu option.
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An example of a layer peeling trace is shown in Figure 3.44. This figure depicts
a multi-segment cable of varying impedance (50-125-75-63 ohms) with an open
fault at the end. The corrected impedance of the final segment is within 2-3
ohms of the actual value, which represents an ~80% reduction in impedance
error when compared with the uncorrected live TDR trace.

Figure 3.44. Example layer peeling trace (yellow, bottom) versus live TDR
trace (white, top). The layer peeled trace reduces the impedance error in
the final cable segment (green arrows) by ~80%.

3.11.23. Fast Fourier Transform (FFT) Traces
The CT100B can calculate FFT frequency domain information from live and
scanned TDR traces. FFT traces can be used to show the frequency domain
content of a trace or portion of a trace between cursors, and comparisons of
FFT traces can be used to demonstrate differences and/or changes in frequency
content, such as between different types of connectors or cable faults. To create
an FFT trace, use the following procedure:
1. Select the live trace with the SELECT button.
2. Use the CURSOR button and the HORIZONTAL POSITION knob to set
the boundaries for the FFT with a cursor at either end.
3. Press the SCAN button, and then select Math → FFT Tools.
4. Select Apply FFT. The CT100B will now take a high resolution scan of the
live trace between the cursors, and then convert the scan into an FFT plot.
FFT traces can be stored, reloaded, and transferred to CT Viewer 2 just like
normal scanned traces.

3.11.24. Web Server
The CT100B is able to export raw data and images in real time over Ethernet.
To enable this feature, follow this procedure:
1. Select MENU → Settings → Network Settings.
2. Toggle Web Server to On.
3. Press Show IP Config. and note the IPV4 address.
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4. Using a web browser, navigate to http://xxx.xxx.xxx.xxx/, where the
xxx.xxx.xxx.xxx is the IPV4 address you noted in step 3. From this web
page you can access:
a) screenshot.bmp. This displays a current snapshot of the screen, ready
to download.
b) Live Stream. This displays a live view of the screen, updated multiple
times a second.
c) Live Control. This displays the live, updating view of the screen and
also allows remote control of the front panel controls.
d) Download/Upload Traces. This displays a list of the traces stored on
the CT100B and allows transfer of traces to and from the PC.
e) trace.csv. This downloads a .csv text file with m vs. millirho and ns
vs. millirho columns.
f) selected.csv. This downloads a .csv text file with user-selected
columns (these can be chosen at Settings → Network Settings →
selected.csv Options).
g) PDF and HTML versions of the CT100B Operator’s Manual.

3.11.25. Remote Control
Using the accompanying CT Viewer™ 2 software, the CT100B can be operated
by remote control. The remote control system allows the operator to manipulate
traces and store movies of traces over time. Remote control only functions over
Ethernet connections. It does not work when the CT100B is connected by USB
only.
Refer to Section 4.1.3 Send Saved Traces Using Ethernet and
Section 4.1.4 Using Remote Control for instructions on connecting CT Viewer 2
to the CT100B and enabling remote control. Please consult the CT Viewer 2
Quick User Guide for more information about using remote control and
manipulating a remote TDR trace.

3.11.26. Cable Type Library
The CT100B has a library of common cable types and associated velocities of
propagation. Vp for these cable types can be loaded from the library. The user
can add custom cable types to the CT100B as well. The user-added cable types
are stored and accessed separately from the standard cable types.
3.11.26.1. Load a Cable Type’s Vp
To load a cable type, follow this procedure:
1. Press the FILE button. The File menu appears.
2. Select Reference Cable Types or Custom Cable Types from the menu. An
interface appears that allows you to scroll through the cable types with the
M-FUNCTION knob.
3. Highlight the desired cable type and press Select. Vp is now set to the
value for that cable type.
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3.11.26.2. Custom Cable Types
The CT100B is able to save custom cable types. Use the following procedure to
save a custom cable type:
1. Press the FILE button. The File menu appears.
2. Select the Custom Cable Types menu option to access user-editable cable
types with menu options Add New and Select.
3. When Add New is chosen, a window appears for entering a cable type
name, a Vp for velocity of propagation, and an expected characteristic
impedance for the cable. When the window first appears, Vp will be set to
the current system Vp, while impedance defaults to 50 ohms.

3.11.27. Other Measurement Settings
3.11.27.1. Horizontal Units
Horizontal distance measurements can be displayed in meters, inches, feet,
yards, or centimeters.
1. Select MENU → Measurement menu.
2. Select the Horiz. Units menu item to switch between the different unit
options.
All measurements and all traces are immediately updated to reflect the unit
change. Time in nanoseconds (ns) is displayed separately.
3.11.27.2. Vertical Units
The CT100B is able to change vertical units of the live TDR trace so that it is
displayed in units of reflection coefficient (millirho), impedance (ohms), or
voltage standing wave ratio (VSWR). To change vertical units, use the following
procedure:
1. Select MENU → Measurement menu.
2. Select Vert. Units to toggle through the different options.
Example trace with impedance (ohms) as the vertical unit is shown
in Figure 3.45. Note that the vertical scale is in ohms and the open fault at the
end of the cable on the red (Impedance) trace shows nonlinear relationship
between the reflection coefficient and the impedance described in Section 5.6.
3.11.27.3. Fine Vp Control
By default, the CT100B displays three decimal places for Vp; however, the
CT100B can display six decimal places for Vp when very precise distance
measurements are needed.
1. Select the MENU → Settings → Meas. Settings menu.
2. Select Vp 3 Sig Figs from the menu to toggle the option to Vp 6 Sig Figs.
The CT100B will display six decimal places for the Vp readout on the
screen when Vp 6 Sig Figs is shown on the menu.
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Figure 3.45. TDR trace with impedance vertical units (red, top)
demonstrating vertical scale in ohms and emphasis of the open fault at the
end of the cable. The black trace uses reflection coefficient (millirho) as its
vertical units.
3. When the CT100B is in Vp 6 Sig Figs mode, a new function, Fine Adj.
Vp, is added to the M-FUNC button. When the M-FUNC button is set to
Fine Adj. Vp, turning the M-FUNCTION knob will change the Vp value
by the 6th significant digit. The Vp value can be changed by thousandths
by setting the M-FUNC button to the Coarse Adj. Vp function.
3.11.27.4. Relative Reflection Coefficient (RRC) Method
The CT100B measures the relative reflection coefficient between cursors. When
the two cursors of the CT100B are positioned on either side of a change in
impedance, this measurement is the reflection coefficient for that change. The
relative reflection coefficient is displayed on-screen with a prefix of ∆mρ. To
view the relative reflection coefficient values, go to MENU → Settings →
Display and make sure Rho is toggled on. By default, the value is displayed in
Classic mode, displaying the true reflection coefficient relative to the signal at
the input of the reflection. The CT100B can also measure in 1502C mode, which
displays a reflection coefficient relative to the signal at the input of the cable.
1. Select the MENU → Settings → Meas. Settings menu.
2. Select RRC Classic Mode from the menu. This will toggle the CT100B
between the Classic RRC calculation and the 1502C calculation as
displayed on the screen.

3.11.28. User Configurations
The CT100B allows the user to save individually named instrument
configurations. A saved configuration stores the values of all instrument settings
that can influence trace measurements. A configuration can be called up by its
name, restoring all settings to the values saved in that configuration.
User Configurations can reduce operator error when configuring the TDR to
make important measurements. For this reason it is recommended that User
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Configurations be used when setting up the CT100B for important
measurements, such as quality-control checks on a cable manufacturing line.
If a configuration named DEFAULT is saved, that configuration will be initially
employed whenever the CT100B is powered on.
3.11.28.1. Save Configurations
1. Press the FILE button. The File menu appears.
2. Select the Config Entries menu item. The User Configurations library is
displayed.
3. Select Add New to add a new User Configuration. The CT100B will
prompt you for a configuration name and will save the current instrument
configuration when you press OK. See Section 3.7.2 for information on
using the Keyboard menu.
3.11.28.2. Load Configurations
1. Press the FILE button. The File menu appears.
2. Select the Config Entries menu item. The User Configurations library is
displayed.
3. Scroll through saved configurations with the M-FUNCTION knob.
4. Press Select to load the highlighted configuration. All settings saved in
that configuration are automatically restored. Measurements and traces
are updated to reflect the new Vp, cursor position, and other applicable
settings.
Configurations can also be loaded or reset by pressing the AUTOFIT/HELP
button, choosing Reset Options, and selecting one of the choices listed. See
Section 3.9.4 for more information on the Reset Options menu.

3.11.29. Take a Screenshot
To save a screenshot, first insert a USB drive into the CT100B. Then hold down
the SELECT button and press the M-FUNC button to trigger the screenshot.
A dialog will appear asking for a name for the screenshot. When OK is pressed
on the dialog, the screenshot will be saved to the root directory of the USB
drive.
Alternatively, pressing the Print Screen button on an attached USB keyboard
will also trigger a screenshot.
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The CT Viewer™ 2 host computer software allows users of the MOHR CT100B
TDR Cable Analyzer to transfer, view, and manipulate cable scans that have
been saved on their instruments. This software package allows the user to select
scans from a stored database that can contain thousands of scans and compare,
subtract, or find the first derivative of any of the traces.
This software package will also allow the user to create reports and print plots
that can be imported into Microsoft® Word® or other word processing or report
creation software to create files of traces suitable for transfer to others and to
load trace files created by others.
This section covers how to transfer saved TDR traces to CT Viewer 2. For more
detailed information on installing and using CT Viewer 2, please see the CT
Viewer 2 Quick User Guide.

4.1. Sending Saved Traces to a Computer
When a scanned trace is saved to the CT100B, it can be sent to a computer that
has CT Viewer 2 installed.

4.1.1. Send Saved Traces with a Thumb Drive
1. Insert a USB drive into a USB port on the front of the CT100B. Wait
until the USB drive icon appears on screen.
2. Press the FILE button to bring up the File menu.
3. Choose the Cable Scan Records menu option. A window listing all of the
traces saved to the CT100B appears.
4. Use the M-FUNCTION knob to select a trace to send to the USB drive.
Alternatively use Toggle Selected and Mark All to select multiple or all
traces, respectively.
5. Choose Export → USB from the menu. The select trace(s) will now be
written to the USB drive.
6. Remove the USB drive for the CT100B and insert the drive into a USB
port on the computer.
7. Start CT Viewer 2, and from the File menu in CT Viewer 2, select Open
Trace.
8. Select the scan file name(s) of interest from the thumb drive. The trace(s)
will be loaded into CT Viewer 2 and shown on the screen.
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4.1.2. Send Saved Traces over USB
4.1.2.1. Setup USB Drivers on the Host Computer
The USB drivers need to be set up only once for each computer. The USB
drivers for the CT100B should have been installed with CT Viewer 2. It is
possible to skip this step during the installation. If the drivers aren’t installed,
Windows will inform the user when the CT100B is connected over USB.
4.1.2.2. Send the Traces
1. Start CT Viewer 2 and connect the computer to the CT100B with a
standard USB type A to USB type B cable. Connect to the USB type B
port on the back of the CT100B.
2. Go to the File menu in CT Viewer 2 and select Open Tester. A screen will
appear that will show the serial number of the connected CT100B and a
list of all traces saved on the CT100B.
3. Select a trace to transfer by clicking with the mouse. Select multiple traces
by holding down the Shift or Ctrl key while clicking with the mouse.
4. Select the Transfer To button to send the traces to CT Viewer 2. The
traces will also be shown on the screen.

4.1.3. Send Saved Traces Using Ethernet
4.1.3.1. Setup Ethernet
In order to send traces over Ethernet to a computer, both the computer and the
CT100B need to be setup for the network. Depending on the how your network
is configured, the default settings for the CT100B may work. If not, have your
network administrator setup the network settings for the CT100B and the
computer.
The CT100B network settings are located at MENU → Settings → Network
Settings. The CT100B can get a configuration through DHCP, or it can be
setup with Static Network Settings (see Network Settings in Table 3.4: MENU
Button and Menus).
4.1.3.2. Connect to CT Viewer 2 – First Steps
1. Make sure both the computer and the CT100B are plugged into the
network. The CT100B Ethernet plug is found on the back of the CT100B.
The light on the CT100B Ethernet port should illuminate.
2. Start CT Viewer 2 on the computer.
3. On the CT100B, navigate to MENU → Connect to CT Viewer.
See Figure 4.1. The Find CT Viewer menu button will scan the local
network looking for a PC running the CT Viewer 2 program.
4. Or you can use the Manual Connect option to reconnect to a server you
have used in the past or one that is not on your local network.
See Figure 4.2.
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Figure 4.1. Options under the Connect to CT Viewer menu.

Figure 4.2. Selecting Manual Connect in the Connect to CT Viewer menu
will bring up a server menu.
4.1.3.3. Manual Connection the First Time
1. From the server menu, Select Add PC . A window with various server
settings appears.
2. Use the M-FUNCTION knob to move up and down in the window. Use
the on-screen keyboard or a USB keyboard to enter values. In PC Name,
enter a user friendly name for the computer.
3. In PC Address, enter either a network name or an IP address for the
computer.
4. Do not change the default port number.
5. Press OK to save the server entry, then press Select to connect. If the
connection is successful, a message will appear in CT Viewer 2.
4.1.3.4. Connecting After the First Time
1. Navigate to the MENU → Connect to CT Viewer → Manual Connect
menu. A window showing all the stored server connections will appear.
2. Use the M-FUNCTION knob to highlight the connection for the computer.
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3. Press Select. The CT100B will try to connect to the server. On success, a
message appears in CT Viewer 2.
4.1.3.5. After Connecting
1. Go to the File menu in CT Viewer 2 and select Open Tester. A screen
then appears that shows the serial number of the connected CT100B and a
list of all traces saved on the CT100B.
2. Select a trace to transfer by clicking with the mouse. Select multiple traces
by holding down the Shift or Ctrl key while clicking with the mouse.
3. Select the Transfer To button to send the traces to CT Viewer 2. A dialog
box will appear. Verify that the destination folder is correct and choose
Start Transfer. The traces will appear on the screen.

4.1.4. Using Remote Control
After the CT100B has connected to a computer over Ethernet using the steps in
Section 4.1.3, go to CT Viewer 2 and select Remote Control → Enable Remote
Control.
Once Remote Control has been established, a new, live trace will appear in CT
Viewer 2. This trace will be identical to the trace on the CT100B screen. It can
be moved around or scaled just like any other trace in CT Viewer 2.
Normally the CT100B screen goes blank during remote control. To turn on the
CT100B screen at the same time as Remote Control, select Remote Control →
Assistant Mode in CT Viewer 2.

4.1.5. Record and Playback Real-Time TDR Trace Movies
CT Viewer 2 can record a real-time movie of the TDR trace, useful for detecting
and characterizing transient/intermittent faults. To record a real-time movie of
the CT100B trace, connect to the CT100B as described in the previous section,
and then select Remote Control → Record to Movie File. You will be prompted
to enter a filename for the recording. Select Remote Control → Stop to stop the
recording. To view the individual TDR traces saved in the movie, go to File →
Open Other Files and locate and select the desired movie (CTM) file. Use the >
and < keys to step forward and backward in the file. The time stamp of the
trace is shown as part of the trace label.

70

CT100B TDR Cable Analyzers Operator’s Manual

5. TDR Measurement Theory
The purpose of this section is to familiarize the operator with the basic theory of
time-domain reflectometry measurement theory in preparation for using the
CT100B instrument.

5.1. Time-Domain Reflectometry (TDR)
TDR is a form of closed-circuit radar in which a transient test signal is injected
into a device-under-test (DUT) such as a cable, and reflected voltages are
measured over time to construct a TDR waveform or “trace”. Assuming a
transmission line such as a cable with uniform geometry, the test signal
propagates with a characteristic velocity such that the time can be related to
distance. The changes in reflected voltage in a TDR trace with respect to time
correspond to distance from the test port to impedance changes.
Cable or connector faults are regions where the measured reflection coefficient
and associated impedance are outside of manufactured specification. Cable
faults are almost always broadband with preferential attenuation of higher
frequencies, and indicate one or more of the following problems:
1. Change in the geometry of the conductors with respect to one another,
2. Change in the dielectric properties of the insulator, and/or
3. Partial or complete interruption in one or both of the signal conductors.
Cable faults are important because they degrade signal quality. Short or open
faults completely disrupt signal transmission. In many ways such “hard” faults
are helpful because they are easy to diagnose. However, more subtle partial or
“soft” faults cause portions of the signal energy to be reflected and/or delayed,
contributing to noise. This can show up as reduced bandwidth in microwave/RF
cable systems and increased bit error rates in digital cable systems.
Multiple small faults that are individually insignificant with respect to noise
may contribute in an additive fashion to exceed the overall “noise budget” of the
cable assembly. Because TDR typically measures the transmission line with
sensitivity well below the bit error threshold of most communications systems, it
is useful to find these “insignificant” faults and deviations from manufactured
specification that may contribute to signal integrity problems.

5.2. Reflection Coefficients
The amplitude of reflected voltage at a particular location in a TDR waveform
is determined by the reflection coefficient at that location. The CT100B displays
reflection coefficient on the right hand side of the screen with units of millirho
(mρ) and relative reflection coefficient with prefix of ∆mρ.
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The reflection coefficient is the ratio of the amplitude of the reflected portion of
the test signal to the amplitude of the incident test signal. The reflection
coefficient (Gamma, Γ) is related to the impedance change (Z) at a given point
in a cable according to:
ZL − ZS
Γ=
ZL + ZS
Where ZL is the impedance of the load (e.g., the device under test [DUT]) and
ZS is the source impedance of the TDR, typically 50 ohms but potentially other
values if an impedance matching adapter is being used. The reflection coefficient
uses units of rho (ρ) or millirho (mρ).
Note that the reflection coefficient (Γ) is a complex variable with unique
amplitude and phase for each frequency. However, when measuring reflection
coefficient directly from a TDR trace, the measured value is the average
reflection coefficient over all frequencies in the incident and reflected test
signal.
The CT100B is also able to measure and display frequency-domain complex
reflection coefficient values in the context of S11 return loss and cable loss plots
such as those produced with Vector Network Analyzer (VNA) and Frequency
Domain Reflectometer (FDR) equipment. This is discussed further in
Section 5.11.

5.3. Common Types of TDR Cable Faults
Open faults appear as a pulse upward in the TDR trace (Figure 5.1) because the
fault reflects all of the incident step energy in-phase with the test signal.

Figure 5.1. An open cable fault shows an upward step edge at the location
of the fault.
Short faults appear as a pulse downward in the TDR trace because the fault
reflects all of the incident step energy 180◦ out-of-phase with the test signal
(Figure 5.2).
Short or open faults measured through long lengths of cable (hundreds of feet)
will show long, shallow reflections on the TDR trace because the cable
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Figure 5.2. A short cable fault shows a downward step edge at the location
of the fault.
preferentially attenuates higher frequencies in the test signal, degrading the rise
or fall time of the reflected fault. Figure 5.3 demonstrates a TDR trace with an
open fault at the end of an 824 ft. RG-6 coaxial cable with long, shallow
reflected rise caused by cable attenuation of high frequency components of the
step pulse.

Figure 5.3. An open cable fault at 824 ft.
Faults with reactive components such as capacitance and inductance appear as
either dips below or bumps above the characteristic impedance of the cable,
depending on whether they are in series with the conductor or represent a fault
to ground.
Normal connectors will show up as an impedance discontinuity simulating a
small fault. Depending on the type and quality of the connectors, the expected
impedance variation will differ, as shown in Figure 5.4 and Figure 5.5 for SMA
and BNC type connections. Connector damage and corrosion can change the
impedance profile of a connector over time, typically increasing the excess
impedance of the connector. Periodic surveillance with TDR can be used to
confirm connector performance.
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Figure 5.4. Normal SMA female barrel interconnect measuring 52.1 ohms.

Figure 5.5. Comparison of typical SMA (red trace, bottom) and BNC
(black trace, top) coaxial cable interconnects.
Soft/partial faults can appear anywhere along the cable’s length. Any fault has
the potential to reduce the incident pulse strength for subsequent cable faults
and may change the apparent velocity of propagation. The accuracy of the
Distance-to-Fault measurement of a fault that appears beyond another fault is
reduced.

5.4. Velocity of Propagation (VoP, Vp)
As mentioned in previous sections, a transmission line, such as a cable, has
uniform geometry with a characteristic signal propagation velocity. This velocity
of propagation (Vp, VoP, or VP), sometimes also called the velocity factor (VF)
or wave propagation speed, is the measure of the velocity of an electrical signal
within a cable expressed as a fraction of the speed of light in a vacuum. With
the CT100B, Vp can be set between 0.250000 and 1.000000.
Nominal Vp values for most types of cable can be found in the manufacturer’s
data sheet, and Appendix E: Vp of Common Cables contains nominal values for
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a variety of commonly used cable types. These values can be a good start for
basic cable Distance-to-Fault measurements, however it is important to be aware
that Vp values for a given cable type may vary from manufacturer to
manufacturer and from one manufacturing lot to the next even from the same
manufacturer. In addition, cable aging due to temperature, radiation, or other
environmental parameters may alter the original characteristic velocity of
propagation for a given cable. For this reason, if accuracy is particularly
important for a particular cable Distance-to-Fault measurement, it is generally a
good idea to establish a known Vp for a sample of the specific cable under test.
The velocity of propagation (V p) is related to the dielectric constant (relative
permittivity, εr ) of the dielectric medium according to:
1
Vp≈ √
εr
Velocity of propagation is also related to the distributed inductance (L) and
shunt capacitance (C) of a lossless transmission line according to:
1
Vp= √
c LC

5.5. Distance-to-Fault (DTF) and Cable Length
Once the operator identifies an impedance discontinuity such as a cable fault or
open or short cable termination, the distance to the fault (D) is related to the
velocity of propagation (V p), the speed of light (c), and the measured round-trip
time (t) to the fault, according to:
Vp·c·t
2
The product is divided by 2 because the CT100B measures the time for the
pulse to travel to and from the point of interest.
D=

5.6. Impedance
As mentioned previously, TDR instruments measure reflection coefficient
essentially but must calculate impedance according to:
Z(t) = −ZS

Γ(t) + 1
Γ(t) − 1

Where Z(t) is the impedance at time t, ZS is the source impedance, and Γ(t) is
the reflection coefficient at t. This is the basis for the CT100B ohms-at-cursor
measurements and ZTrace impedance traces. It is important to note that
impedance is nonlinear with respect to reflection coefficient, as shown
in Figure 5.6.
Because TDRs measure reflection coefficient, noise and uncertainty on a TDR
trace is in units of millirho, not ohms. Given a fixed amount of uncertainty in
reflection coefficient, the corresponding impedance uncertainty will be low at
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Figure 5.6. Relationship of impedance (ohms) to reflection coefficient (rho)
for 50 ohm source impedance (marked by red circle).
impedances less than the TDR source impedance (typically 50 ohms) and
increasingly larger and nonlinear for impedance values greater than the TDR
source impedance.
The CT100B factory calibration provides typical vertical accuracy of
approximately 0.1 ohm near 50 ohms and approximately 10-20 ohms near 1000
ohms for most cable testing applications. When impedance measurements are
very important, accuracy can be improved using Vert. Ref. (Section 3.11.15)
and normalized TDR traces (Section 3.11.21).

5.7. Return Loss
Return loss is another way of measuring impedance change in a cable. Return
loss is given in decibels (db) and is always calculated using the relative reflection
coefficient. Return loss is related to the reflection coefficient Γ by the formula:
Return Loss = −20 · log10 |Γ|db
The larger the fraction of energy in the reflected signal, the lower the numerical
return loss value, so that an open or a short that returns 100% of the signal has
a return loss of 0 dB. A very low loss cable will have a large return loss in dB.
Likewise a 50 ohm cable terminated with a perfect 50 ohm load will have very
large return loss in dB. This relationship is shown in Figure 5.7.
Return loss measured directly from a CT100B TDR trace represents the average
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return loss over all frequencies in the step-rise test signal. The CT100B can
measure TDR return loss at cursor and relative return loss between cursors and
optionally displays these values at the right hand of the screen in units of dB,
with ∆dB used for the relative return loss measurement.
The CT100B is also able to measure complex frequency-specific S11 return loss
and cable loss values such as those produced with Vector Network Analyzer
(VNA) and Frequency Domain Reflectometer (FDR) equipment. This is
discussed in further detail in Section 5.11.

Figure 5.7. Relationship of return loss (dB) to reflection coefficient (rho).

5.8. VSWR
Voltage standing wave ratio (VSWR) is a way of displaying reflection coefficient
in a nonlinear way that emphasizes changes in cable impedance. VSWR is the
voltage standing wave ratio and is related to the reflection coefficient Γ
according to:
1 + |Γ|
VSWR =
1 − |Γ|
VSWR measures the ratio of the maximum-over-time amplitude of the nodes
and anti-nodes of the standing wave off of a reflection. If there’s no reflection
(e.g., 50 ohm termination), VSWR will be 1. If all energy is reflected (e.g., short
or open fault), VSWR goes to infinity. This relationship is shown in Figure 5.8.
VSWR is a unitless, scalar value.
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Figure 5.8. Relationship of voltage standing wave ratio (VSWR) to
reflection coefficient (rho). VSWR for 50 ohm load is shown by the red
circle.
The CT100B displays two different VSWR values at cursor. The first, VSWR, is
calculated from the total reflection relative to the CT100B test port source
impedance (50 ohms). The second, ∆VSWR, is calculated from the reflection
between the two cursors. In other words, VSWR is based on the millirho
reflection coefficient, while ∆VSWR is based on the ∆mρ, relative reflection
coefficient calculation. There are menu options in the Display menu to toggle
the display of VSWR and ∆VSWR.
VSWR can also be selected as the vertical scale for a trace. From the Main
menu, go to the Measurement menu and select Vertical Units.

5.9. Rise Time and Spatial Resolution
Spatial resolution is defined by the ability of the operator to distinguish the
presence of two closely spaced faults on a TDR waveform. An accepted rule of
thumb is that the limiting spatial resolution of a TDR instrument is
approximately 1⁄2 of the system rise time (10-90%). This is the time required for
the step signal reflected from an open or short termination to transition from
10% to 90% of the final step amplitude. The estimated spatial resolution R is
calculated by the following equation:
1
R∼
= · c · Vp · tr
2
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where c is the speed of light and tr is the system rise time. If the velocity of
propagation Vp is taken to be 0.66 and the TDR has a 100 ps system rise time,
the calculated resolution is ~10 mm.
Faster system rise times allow a given TDR instrument to more faithfully
represent partial cable faults such as shield nicks or kinks, as shown
in Figure 5.9. This figure depicts a simulation of the difference between a 90 ps
rise time TDR and an 800 ps rise time TDR (typical of low-cost TDR
instruments) for characterizing two 1 cm long, 75 ohm faults spaced 1 cm apart
on a 50 ohm cable. The 800 ps rise time TDR detects only a single fault and
grossly underestimates the severity of the fault.

Figure 5.9. Simulated comparison of a 90 ps rise time TDR (green) and an
800 ps TDR (red) with respect to the ability to depict two 1 cm long, 75
ohm faults spaced 1 cm apart on a 50 ohm cable. Notice how the faster
TDR (90 ps) resolves each fault individually. The blue lines represent a
theoretically perfect response.

5.10. Timebase/Cursor/Horizontal Resolution
Timebase, cursor, or horizontal resolution refers to the horizontal spacing of
samples along the TDR trace. In order to faithfully depict the TDR profile of a
connector or cable fault, the cursor resolution should be at least 5 to 10 times
higher than the spatial resolution. For the example just shown in Figure 5.9, it
is unlikely that the cursor resolution for the slower rise time instrument would
be adequate to reliably depict the fault in the first case.
Cursor resolution also comes into play when precise length or phase matching of
cables is being carried out, in which the cursor resolution must be sufficient to
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adequately depict the difference in length between cables. Typically the cursor
resolution should be 10 times higher than the intended length accuracy.
With respect to frequency-domain measurements, very high cursor resolution
ensures adequate frequency bandwidth because the number of sampled data
points in the time domain translates into frequency resolution in the frequency
domain.

5.11. Frequency-Domain Measurements
5.11.1. Scattering Parameters
The scattering parameter or S-parameter approach to describing a device under
test (DUT) assumes that a DUT is a black box network with N ports. The
S-parameter matrix contains the complex reflection and transmission coefficients
of the network, describing the amplitude and phase of reflected and transmitted
values from each port in response to excitation of one or more of the ports.
According to convention, the scattering parameter Sxy represents the response
of the network in terms of reflected and/or transmitted voltages at port x in
response to excitation of port y. S11 and S22 are the complex reflection
coefficient matrices of port 1 and 2, respectively. S21 and S12 are the forward
and reverse complex voltage gain matrices for port 1 and port 2, respectively.
Considering a 2-port network with incident voltage waves a1 = V1+ and
a2 = V2+ and reflected waves being b1 = V1− and b2 = V2− , the 2-port
S-parameter matrix is described by:



b1
b2



=



S11
S21

Solving for S11 gives:

S12
S22



S11 =

V−
b1
= 1+
a1
V1

S21 =

V−
b2
= 2+
a1
V1

Solving for S21 gives:

a1
a2



Passive networks like cables, splitters, attenuators, and combiners can be
considered reciprocal networks such that S11 = S22 and S21 = S12 . One-port
measurements can be used to characterize the return loss (S11 /S22 ) and
insertion loss (S21 /S12 ) of a variety of 2-port passive networks such as cables.
This will be discussed in Cable Loss (S21 ), Section 5.11.4.
You can measure S-parameters directly in the frequency domain using a VNA
instrument and indirectly in the time domain using a TDR instrument. The
TDR instrument performs a discrete Fourier transform (DFT) operation to
decompose a TDR trace into the frequency domain.
When calibration is performed at the test plane using open, short, and 50 ohm
load (OSL) terminations, the CT100B is able to mathematically subtract
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systemic errors in the pulser and sampler electronics from the measured trace,
improving S-parameter accuracy.
S-parameters measured with TDR instruments are accurate with sufficient
dynamic range for most applications. Figure 5.10 shows a comparison of return
loss for a 2.4 GHz WiFi patch antenna measured using a handheld VNA and
CT100HF TDR. The TDR-derived return loss measurements show good
accuracy from DC to approximately 8.3 GHz. Both spectra clearly show the 2.4
GHz bandpass region expected for a 2.4 GHz WiFi antenna.

Figure 5.10. Comparison of S11 return loss of a 2.4 GHz WiFi patch
antenna measured using a handheld VNA (Agilent® FieldFox N9927A,
green) and TDR (CT100HF, blue), showing good agreement from DC to
~8.3 GHz. Note bandpass in the 2.4 GHz region.

5.11.2. Return Loss (S11 )
The complex return loss S11 is expressed as:
Return Loss RL = −20 · log10 |S11 |dB

5.11.3. Insertion Loss (S21 )
The complex insertion loss S21 is expressed as:
Insertion Loss IL = −20 · log10 |S21 |dB
True 2-port insertion loss measurements require a 2-port instrument; however
the cable loss measurement described below uses the reciprocity feature of
passive networks to determine insertion loss from cables and other suitable
2-port networks using a 1-port test instrument.
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5.11.4. Cable Loss (S21 )
Cable insertion loss in dB is additive per unit length. Assuming that port 2 of a
2-port DUT (e.g., a coaxial cable) is terminated with a short (or open) adapter
such that all (or nearly all) of the incident voltage trace is reflected back to the
TDR instrument, insertion loss (S21 ) is half of the corresponding S11 return loss
measurement in dB:
RL
dB
Cable Loss CL =
2
Again, this relationship is valid if the cable is terminated with a short or open.
One drawback to this technique is that the round-trip insertion loss reduces the
length of cable that can be tested over a given bandwidth relative to a 2-port
measurement because the attenuation of the test signal is doubled. However, for
many applications it is adequate.

5.12. Smith Charts
The impedance Smith chart is a useful graphical tool for visualizing complex
impedances and scattering parameters as shown by Figure 5.11. The CT100B
includes Smith chart functionality that can be used to simplify transmission line
troubleshooting and impedance matching as described in Section 3.11.20.

Figure 5.11. Impedance Smith chart relationships.

5.13. Normalized TDR Traces
The S-parameter OSL calibration process mathematically models the TDR
pulser-sampler system as a two-port error network and subtracts systematic
pulser-sampler errors from the S11 matrix. Convolution of the S11 matrix with
an idealized Gaussian step or other idealized excitation signal allows the
CT100B to create and display a normalized TDR trace. The normalized TDR
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trace has lower aberration and improved impedance accuracy compared with the
original TDR trace.
Although cable fault detection is the most sensitive when using an excitation
signal with the fastest rise time possible, by changing the rise time of the
Gaussian step, the importance of a given cable or connector fault can be
estimated at different signal rise times and bandwidths. For instance if the cable
under test is typically used with 1 ns rise time signals, the severity of a cable
fault can be determined by using a 1 ns rise time normalized TDR trace.
Localized cable faults will always appear less severe when examined using slower
rise time excitation signals.

5.14. Layer Peeling/Dynamic Deconvolution
Layer peeling (or dynamic deconvolution) is a general method to solve the
inverse scattering problem in partially reflective transmission lines such as
cables. When applied to TDR traces, this method attempts to extract the
underlying real reflection coefficients and impedance in the presence of multiple
reflections caused by the presence of impedance discontinuities in the cable
assembly under test.
As implemented in the CT100B (see Section 3.11.22), the layer peeling method
iteratively examines the TDR trace at each time step and attempts to correct
for forward and backward signal propagation to extract impedance values at
each time step. This is diagrammed in Figure 5.12 showing measured voltages
V (t) taken from the TDR trace and their relationship to actual reflection
coefficients (Γ) at time (t) and impedance values (Zx ) at different physical
distances. The diagram shows that for each time step forward in the TDR trace,
there are increasingly complex contributions from forward and backward
reflections as they interact with each new impedance boundary.
For instance, the test signal moving forward from the Z0 /Z1 impedance
boundary is reduced by the energy reflected by the Z0 /Z1 boundary. Likewise
the Z1 /Z2 impedance boundary is “tested” by the original TDR test signal at
time t1 but also interacts with reflected signals at every subsequent time point
due to internal reflections in the cable. The layer-peeled TDR trace partially
corrects for the presence of these multiple reflections and provides more accurate
impedance values. This effect is most pronounced when there are multiple large
impedance transitions in a cable assembly and at short and open faults.
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Figure 5.12. Layer peeling scattering diagram relating measured TDR trace
(V [t]) to actual impedance changes (Z[x]) and their associated actual
reflection coefficients (Γ[x, t]).
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6.1. Options
Model CT100B (BNC) – self-grounding BNC test port
Model CT100B (SMA) – stainless-steel SMA test port
Model CT100HF – high-frequency sampler, stainless-steel SMA-type test port

6.2. Accessories
6.2.1. Service accessories (CT100B / CT100HF)
Technical Manual, Printed
Technical Manual, Digital w/ CT Viewer™ 2 Installation

CT100B-M-TSM-xxx*
CT100-S-CTVTSMxxx*

* xxx applies to revision number. Accessory part number is incremented per
revision.

6.2.2. Standard BNC Accessories – CT100B (BNC)
BNC 50 ohm 36 in. Reference Cable
SMA 50 ohm Terminator
Connector, SMA female to BNC male
BNC Female to Female Adapter
BNC Male to Male Adapter
BNC Shorting Cap
24 VDC External Charger/Power Supply
Operator’s Manual, Printed
CT Viewer™ 2 Quick User Guide, Printed
CT Viewer™ 2 Installation DVD, w/ Digital Operators
and CT Viewer™ 2 Manuals
Soft Carrying Case
NIST-Traceable Calibration with Certificate
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CT100-AC-W536
CT100-AC-ER50-S
CT100-AC-ISFBM
CT100-AC-IBFF
CT100-AC-IBMM
CT100-AC-IBS
CT100-AC-PS
CT100B-M-OM-xxx*
CT100B-M-CTVMxxx*

CT100-S-CTV2-xxx*
CT100-AC-CS
CT100-AC-NISTCC
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6.2.3. Standard SMA Accessories – CT100B (SMA), CT100HF
SMA 50 ohm 36 in. Reference Cable
SMA 50 ohm Terminator
SMA Male to Male Adapter
Connector, SMA female to BNC male
Connector, SMA male to BNC female
Connector, SMA Female Short
SMA Shorting Cap
24 VDC External Power Supply
Operator’s Manual, Printed
CT Viewer™ 2 Quick User Guide, Printed
CT Viewer™ 2 Installation DVD, w/ Digital Operators
and CT Viewer™ 2 Manuals
Soft Carrying Case
NIST-Traceable Calibration with Certificate

CT100-AC-W536-S
CT100-AC-ER50-S
CT100-AC-ISMM
CT100-AC-ISFBM
CT100-AC-ISMBF
CT100-AC-ISSF
CT100-AC-ISS
CT100-AC-PS
CT100B-M-OM-xxx*
CT100B-M-CTVMxxx*

CT100-S-CTV2-xxx*
CT100-AC-CS
CT100-AC-NISTCC

6.2.4. Optional accessories
Hard Carrying Case (Pelican)
MIL-STD-1553B/TRB Adapter Kit
OSL S-Parameter Calibration Kit SMA
3.5 ft-lbs (0.4 Nm) Torque Wrench
Phase-Stable Cable 3 ft. SMA(M-M)
Phase-Stable Cable 3 ft. SMA(M-F)
25 ft. (300”) 50 ohm test cable
Small Form Factor Keyboard
Clear Screen Protector Pack
BNC Adapter Kit
SMA Adapter Kit
Impedance Matching Kit 75, 93, 125 ohm (BNC)
Impedance Matching Adapter, 50 to 75 ohm
(BNC)
Impedance Matching Adapter, 50 to 93 ohm
(BNC)
Impedance Matching Adapter, 50 to 125 ohm
(BNC)
Internal Battery (2700 mAh NiMH, 12 AA cells,
14.40 V, 38.88 Wh)
Differential Adapter Dual BNC
Differential Adapter TRB
Differential Switcher Firewire
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CT100-AC-CH
CT100-AK-TRB
CT100-AK-CALSMA
CT100-TL-TORX7
CT100-ACPSCSMSM36
CT100-ACPSCSMSF36
CT100-AC-W5300
CT100-AC-KBD
CT100-AC-SPC
CT100-AK-BNC
CT100-AK-SMA
CT100-IK-BNC
CT100-AC-I5075-BNC
CT100-AC-I5093-BNC
CT100-AC-I50125BNC
CT100-AC-B2700
CT100-DA-DBNC
CT100-DA-TRB
CT100-SW-1394
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A. Specifications
A.1. Electrical Specifications
Characteristic
Reflected rise time, CT100B 10-90%
Reflected rise time, CT100B 20-80%
Reflected rise time, CT100HF 10-90%
Reflected rise time, CT100HF 20-80%
Jitter
Output impedance
Pulse amplitude

Specifications
150 ps typ, 200 ps max
100 ps typ, 150 ps max
100 ps typ, 130 ps max
60 ps typ, 90 ps max
15 ps max
(peak-to-peak)
50Ω ± 2%
300 ± 10 mV

Pulse width

Fixed: 1.000-2.000,
5.000-6.000,
20.00 − 21.00µs

Pulse repetition time

Fixed: 4.000 ± 0.002,
20.00 ± 0.02,
80.00 ± 0.02µs

Sequential sampling rate

Fixed: 250.0 ± 0.2,
50.00 ± 0.04,
12.50 ± 0.02 kHz

Vertical scale
Vertical accuracy

0.5 mρ/div
±3% full scale

Vertical position

Any trace point is
movable to the center
of the screen.
50 to 90%
45 to 90%
±5 mρ peak-to-peak
±1 A max
1/45 of one major
division
≤-0.3 m (-1 ft.) to >
10000 m (33000 ft.)
0.0002 m (0.0007 ft.)

Sampling efficiency, CT100B
Sampling efficiency, CT100HF
Noise
Input susceptibility
Distance cursor resolution
Cursor readout range
Cursor readout resolution
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Notes
10 to 90%, into 50
20 to 80%, into 50
10 to 90%, into 50
20 to 80%, into 50
< 1 ps rms typ.

Averaged value int
50Ω
Averaged values
change for short,
medium, and long
cable length settin
respectively
Averaged values
change for short,
medium, and long
cable length settin
respectively
Averaged values
change for short,
medium, and long
cable length settin
respectively
< ±1% of
measurement typ.

into 50Ω
into 50Ω
into diode clamps
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Characteristic
Distance measurement accuracy

Vp range
Vp default resolution
Vp fine resolution
Vp accuracy (coarse)
Vp accuracy (fine)
USB host port

Specifications
< 1 cm (0.3 in.) or
< 0.5% of
measurement plus
uncertainty in Vp,
whichever is greater
< 1Ω to > 1.5kΩ
3 significant digits
±10%, relative
measurement ±2%
0.01 m/div (0.03
ft/div) to ≥ 61 m/div
(200 ft/div)
(variable with pulse
width)
< 0 m to > 1000 m
(3300+ ft)
Any distance to full
scale can be moved on
the screen.
0.250000 to 1.000000
0.001
0.000001
±0.1%
±0.0001%
USB 1.1

USB client port

USB 1.1

Ethernet port

The instrument
includes a 10/100mbps
Ethernet port for
network
communication.
24 VDC, 2.5 A,
positive tip. Use only
the MOHR-approved
power supply.
12 NiMH AA cells,
fused at 2.5 A
> 6 hours. Power save
options may extend
operating time.
2.5 hours from fully
discharged state
Charging discontinues
once full charge is
attained.

Impedance readout range
Impedance resolution
Impedance accuracy
Horizontal scale

Horizontal range
Horizontal position

DC power supply

Battery pack
Battery operation time

Battery charge time
Overcharge protection
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Notes
< ±0.05% of
measurement typ.

< ±1%typ.(0 to 1kΩ

Front USB host
connector is powere
(500 mA limit) with
500 VDC isolation
from test port.
500 VDC isolation
from test port.
500 VDC isolation
from test port.

500 VDC isolation
from test port.

Pack may wear out
over time.
18V full charge dow
to 12V battery low,
35% duty cycle.
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Characteristic
Discharge protection

Specifications
Instrument turns off
prior to battery
damage
2.7 Amp-hours
(nominal-new)

Charge capacity

Notes
Software shutdown
when battery is lo

A.2. Environmental Specifications
A.2.1

Temperature

Operating temperature
Non-operating temperature

0◦ to +50◦ C
-20◦ C to +60◦ C

A.3. Mechanical Specifications
A.3.1

Weight

Without cover
With cover

A.3.2

2150 g (4.740 lb.)
2323 g (5.121 lb.)

Dimensions

Height
Width w/ handle
Width w/o handle
Depth w/ cover
Depth, handle extended

10.9
29.2
26.2
17.5
27.9

cm
cm
cm
cm
cm

(4.28 in.)
(11.50 in.)
(10.30 in.)
(6.90 in.)
(11.00 in.)

A.4. Certifications and Compliances
A.4.1

EC

The CT100B and CT100HF comply with all applicable EU directives.

A.4.2

FCC Compliance

CT100B and CT100HF emissions comply with FCC Code of Federal
Regulations 47, Part 15, Subpart B, Class A Limits.
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A.4.3

EMC

CT100B and CT100HF comply with MIL-PRF-28800F, MIL-STD-461F RE102,
CE102, and IEC61000.

A.4.4

Shock and Vibration

CT100B and CT100HF comply with MIL-PRF-28800F (class 3).

A.4.5

Temperature and Humidity

CT100B and CT100HF comply with MIL-PRF-28800F (class 3).

A.4.6

Explosive Atmosphere

CT100B and CT100HF comply with MIL-STD-810-G 511.5 Procedure 1
(+55°C, 0-4600 m).

A.4.7

US Military Classification

CT100B and CT100HF are class 3 instruments as per MIL-PRF-28800F.
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B. Operating Performance Checks
B.1. General Information
The CT100B Operator Performance Checks are a series of procedures used to
verify the calibration of a CT100B TDR. The following series of checks should
be performed after a unit has been newly calibrated to verify compliance to
published specifications, but may also be performed to determine if calibration
is required. It is recommended to perform these checks at least every 6 months.
See Section D.4 for more information on calibration.
The following series of steps are designed to allow a CT100B operator to
completely verify the properties of an individual CT100B unit to each published
specification. Throughout this procedure any references made to the CT100B
should be considered applicable to the CT100HF and CT100S.
NOTE: Operator Performance Checks should not be considered CT100B calibration.

NOTE: If a CT100B fails any Operator Performance Check,
it should be serviced by a qualified repair facility.

B.2. Required Equipment

Table B.1. Required Performance Check Equipment for CT100B
Item

MOHR part number

Precision 50 Ω terminator
Connector, SMA female to
BNC male
50 Ω 36 in. reference cable
Shorting cap
BNC male to male adapter

CT100-AC-ER50-S
CT100-AC-ISFBM
CT100-AC-W536
CT100-AC-IBS
CT100-AC-IBMM
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Table B.2. Required Performance Check Equipment for CT100HF and
CT100B with SMA Option
Item

MOHR part number

Precision 50 Ω terminator
Connector, SMA male to BNC
female
Shorting cap
50 Ω 36 in. reference cable

CT100-AC-ER50-S
CT100-AC-ISMBF
CT100-AC-ISS
CT100-AC-W536-S

Additionally, a device capable of taking accurate pulse measurements with
documented calibration will be required, and, if working with a CT100B [BNC],
an open terminator will be needed. Coaxial adapters with low TDR reflections
(< 5Ω) are required in any cases where adapters are used.

B.3. Getting Ready
Disconnect any cables from the front BNC or SMA connector. Connect the
instrument to the external 24V power supply connected to a standard 3-prong
AC source.
Allow the unit to warm up until it displays a steady temperature.

B.4. Operator Performance Checks
B.4.1

Jitter, Noise, Rise Time, and Sampling Efficiency Checks

1. Connect a 50 ohm terminator to the CT100B front panel cable connector.
2. Select the MENU → Settings → Diagnostics menu item to enter the
Diagnostics submenu.
3. Select Jitter. After a moment, a results window appears with a list of
measurements.
The value for Jitter used in the specification for a CT100B is Jitter P2P. The
value for Noise is Noise P2P.
The value for the 20-80% and 10-90% Reflected Rise Times are both displayed
as 20-80 Rise and 10-90 Rise, respectively.

B.4.2
1.
2.
3.
4.
5.
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Output Impedance Check

Disconnect any cables from the CT100B front panel cable connector.
Position a cursor before the falling edge of the trace.
Position the second cursor well beyond the falling edge.
Attach the 50 ohm terminator to the CT100B.
The difference in ohms between the two cursors is a measure of the
deviation of output impedance from 50 ohms.
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B.4.3

Pulse Amplitude Check

1. Pulse amplitude measurement should be taken with a device that can
accurately measure frequency, pulse width, period, and amplitude.
2. Set the device input impedance to 50 ohms.
3. Connect one end of the 36 in. reference cable to a capable pulse
measurement device and the other end of the 36 in. reference cable to the
CT100B front panel cable connector. A trace should appear on the device
display.
4. Switch the CT100B into the Short pulse setting from the Main menu
Cable Len setting.
5. Measure the pulse amplitude coming off the front panel cable connector.
The averaged pulse amplitude into 50 ohms should be between 290 mV
and 310 mV.
6. Repeat pulse amplitude comparison for Medium and Long settings.

B.4.4

Pulse Width Check

1. Pulse width measurement should be taken with a device that can
accurately measure frequency, pulse width, period, and amplitude.
2. Set the device input impedance to 50 ohms.
3. Connect one end of the 36 in. reference cable to a capable pulse
measurement device and the other end of the 36 in. reference cable to the
CT100B front panel cable connector. A trace should appear on the device
display.
4. Switch the CT100B into the Short pulse setting from the Main menu
Cable Len setting.
5. Measure the pulse width coming off the front panel cable connector. The
average pulse width should be between 1.000-2.000 µsec for Short,
5.000-6.000 µsec for Medium, and 20.00-21.00 µsec for Long.
6. Repeat pulse width check for Medium and Long settings.

B.4.5

Pulse Repetition Period Check

1. Pulse repetition rate measurement should be taken with a device that can
accurately measure frequency, pulse width, period, and amplitude.
2. Set the device input impedance to 50 ohms.
3. Connect one end of the 36 in. reference cable to a capable pulse
measurement device and the other end of the 36 in. reference cable to the
CT100B front panel cable connector. A trace should appear on the device
display.
4. Switch the CT100B into the Short pulse setting from the Main menu
Cable Len setting.
5. Measure the pulse repetition rate coming off the front panel cable
connector. The average pulse repetition rate should be 4.000±0.002 µsec
for Short, 20.00±0.02 µsec for Medium, and 80.00±0.02 µsec for Long.
6. Repeat pulse width check for Medium and Long settings.

B.4.6

Pulse Frequency Check

1. Pulse frequency measurement should be taken with a device that can
accurately measure frequency, pulse width, period, and amplitude.
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2. Set the device input impedance to 50 ohms.
3. Connect one end of the 36 in. reference cable to a capable pulse
measurement device and the other end of the 36 in. reference cable to the
CT100B front panel cable connector. A trace should appear on the device
display.
4. Switch the CT100B into the Short pulse setting from the Main menu
Cable Len setting.
5. Measure the pulse frequency coming off the front panel cable connector.
The averaged pulse frequency should be 250.0±0.2 kHz for Short,
50.00±0.04 kHz for Medium, and 12.50±0.02 kHz for Long.
6. Repeat pulse width check for Medium and Long settings.

B.4.7

Sequential Sampling Rate Check

The sequential sampling rate is the reciprocal of the pulse repetition time.

B.4.8

Vertical Scale Check

Twist the VERTICAL SCALE knob clockwise. Vertical scale should drop to 0.5
millirho/div and the trace should expand accordingly.

B.4.9

Vertical Accuracy Check (millirho)

1. Attach an open to the CT100B.
2. Position a cursor on the trace so that it is well after the open.
3. The vertical measurement should be between 940 millirho and 1060
millirho.

B.4.10

Vertical Position Check

1. Increase vertical scale to 500mρ/div by turning the VERTICAL SCALE
knob counter-clockwise.
2. Use the VERTICAL POSITION knob to move the live trace completely
above the horizontal midline of the screen.
3. Use the VERTICAL POSITION knob to move the live trace completely
below the horizontal midline of the screen.
A CT100B must succeed at both operations to pass the Vertical Position
Check.

B.4.11

Distance Cursor Resolution Check

Distance cursor resolution is a value determined by a constant. It can be
measured by counting distinct locations that a cursor may occupy between two
division lines, including one of the division lines.
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B.4.12

Cursor Readout Range Check

In the Measurement menu, toggle on Extra Long Mode.
Turn the HORIZONTAL SCALE knob counter-clockwise until horizontal scale
is maximized.
Using the M-FUNC button and M-FUNCTION knob, set Vp to 1.000.
With the HORIZONTAL SCALE knob, position a cursor at the most far right
position possible.
The absolute distance measurement for the cursor is the upper limit for cursor
readout range. This number should be larger than 10,000 m or 33,000 ft.
Position a cursor at the most far left position.
The absolute distance measurement for the cursor is the lower limit for cursor
readout range. This number should be less than -1 ft. (-0.3 m).

B.4.13

Cursor Readout Resolution Check

1. Use the HORIZONTAL SCALE knob to set the horizontal scale to
0.00330 ft./div or 0.001 m/div.
2. Position a cursor on the screen and note the absolute distance
measurement for the cursor.
3. Move the cursor the smallest possible step using the HORIZONTAL
POSITION knob. The difference between the new distance measurement
and the previous is the minimum cursor readout resolution.

B.4.14

Distance Measurement Accuracy Check

Accuracy is determined by taking a cable of known length and velocity and
comparing the known values against measured values. Accuracy is reported as a
percentage. When determining accuracy, ensure that horizontal calibration has
been performed accurately.
Accuracy should be checked for Short, Medium, and Long settings.

B.4.15

Ohm Readout Range Check

1. Connect the 36 in. reference cable to the CT100B.
2. Position a cursor on the trace well beyond the end of the cable. The
vertical impedance measurement should read ≥ 1.5k ohms.
3. Position a cursor on the trace well before the leading edge of the pulse.
The vertical impedance measurement should read ≤ 1 ohm.

B.4.16

Resolution Check

Position a cursor at a point of the trace where the vertical impedance
measurement is greater than 1 ohm and less than 1500 ohms. The CT100B
should display 3 digits for this measurement.
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B.4.17

Vertical Accuracy Check (ohms)

1. Vertical accuracy is checked by comparing CT100B impedance
measurements against a load of known impedance. The supplied 50 ohm
terminator is required.
2. Within the Main → Settings → Display submenu, select the Ohms Rho
button until Ohms is marked with asterisks. An ohms at cursor reading
now appears on the right side of the screen.
3. Connect a 50 ohm terminator onto the front panel cable connector.
4. Move a cursor out to a length greater than 300 ns. Impedance may change
a small amount from point to point.
5. Average impedance amongst a number of points along the trace determines
vertical accuracy. Impedance at cursor should be between 45 and 55 ohms.
6. Vertical accuracy should be checked for Short, Medium, and Long cable
lengths.

B.4.18

Horizontal Scale Check

1. From the Main menu, set Cable Len to “Long”.
2. Using the M-FUNC button and M-FUNCTION knob, set Vp to 1.00.
3. Turn the HORIZONTAL SCALE knob counter clockwise. Horizontal scale
should increase beyond 61 m/div or 200 ft./div.
4. Turn the HORIZONTAL SCALE knob clockwise. Horizontal scale should
decrease below 0.01 m/div or 0.03 ft./div.

B.4.19

Horizontal Range Check

See the cursor readout range instructions in Section B.4. Horizontal range and
cursor readout range are always equal.

B.4.20

Horizontal Position Check

This test is passed implicitly when the Cursor Readout Range and Horizontal
Range checks are passed.
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C. Operator Troubleshooting
C.1. General Information
Use this troubleshooting guide when there is a problem with a CT100B or to
assist with problem identification. This will help you to determine if the
instrument should be repaired or is acceptable to continue using. Any time one
of the internal thermal fuses actuates with an audible click, indicating thermal
overload, turn off the rear panel battery-disconnect switch immediately and have
the instrument serviced as soon as possible.
CAUTION: DO NOT continue using the CT100B if it exhibits signs of thermal overload, such as emitting heat or
smoke, or if it smells of burning plastic.

C.2. Power On Test
Verify that the back switch is in the ON position. Press the red front button to
turn the instrument on. If the instrument does not show anything on the screen
within 20 seconds, turn the back switch to the OFF position, unplug all USB
and Ethernet devices, and attempt to turn it on again.

C.3. Functional Block Diagram and Troubleshooting
Flowcharts
Use the following functional block diagram and troubleshooting flowcharts for
various parts of the CT100B to determine if your CT100B requires service. See
Section C.4: Parts List, for a replaceable parts list.
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C.3.1

Functional Block Diagram

24V DC Charging
from AC adapter
CT100-AC-PS

Internal 12 Cell
NiMH Battery Pack
CT-100-AC-B2700

Client USB,
Ethernet

DC Power,
Temperature

DC Power

Back Panel Assembly
CT209B

Ethernet,
Client USB
Analog Power
W1W5C1

Ethernet W2W6C1,
Client USB W2W6C3,
Serial Port
+5V Digital

Front Panel
Assembly
CT290B

Video Cable
W2W7C1
Serial Port
W2W3C1

Digicomp
A2A1

Data Interface
W2W1C1

Analog Board
A1

USB Host
W2W3C2
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User Input

Analog Signal

Host USB,
Buttons, Knobs

Test Port
W1W9C1
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C.3.2

Main Diagnostic Sequence

Start of Diagnostics

External DC
Diagnostics
(C.3.3)

Status/Decision/Observation
Action
Procedure Callout

Does the device
power on?

YES

Perform
Startup
Diagnostics
(C.3.4)

Start and End of procedure

PASS

FAIL

FAIL

Perform Front
Control Panel
Verification
(C.3.5)

PASS

FAIL

Perform
Analog
Diagnostics
(C.3.6)

NO

FAIL

Perform TDR
Trace
Verification
Procedure
(C.3.7)

FAIL

Perform USB
Client and
Ethernet
Verification
(C.3.8)

Does a trace
appear on the
device?

PASS

YES

PASS

NO

PASS

FAIL

Perform Real
Time Clock
Verification
(C.3.9)
PASS

FAIL

Perform File IO
Verification
(C.3.10)

PASS
Return to MOHR for
factory Diagnosis and
Repair

Return to MOHR for
factory Diagnosis and
Repair

Device is in working
order
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C.3.3

External DC Diagnostics

Start DC Power
Supply Diagnostics

Plug 24 volt DC
power supply into a
wall socket

Replace power
supply
(CT100-AC-PS)

Yes

Change to a working
AC wall outlet

Does the green light on the
power supply come on?

NO

NO

Does the AC
outlet work?

Verify the power
supply is firmly
plugged in to the AC
cord and outlet

YES
Finished DC Power
supply Diagnostics

100

YES

Does the light on the
power supply come on?

NO

Test outlet with
working device or
outlet tester
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C.3.4

Startup Diagnostics

Start

Is the screen
blank/white and
unchanging for
>1 minute?

YES

NO

Did the MOHR
splash screen
appear?

NO

YES

Did a progress
bar appear?

NO

YES

Is the progress
bar frozen or
reporting an
error?

YES

NO

Is the device
locking up after
the progress bar is
finished?

YES

NO

PASSED

FAILED
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C.3.5

Front Control Verification

Start Front Control
Diagnostics

Press the Blue
Menu Button

Does the main
menu appear?

YES

Choose Settings ->
Diagnostics menu
item.

Choose “Front Panel
Check” menu item

NO

NO

Does
The front panel
diagnostics screen
appear?

Turn each knob left
and right and press
each button except
the red one.

NO

Do all
of the button and
knob icons turn
grey?
YES

Press the red
power button.

NO

Did the
front panel
diagnostics screen
disappear?

YES
FAILED

102

Passed
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C.3.6

Analog Diagnostics

Start Trace
Diagnostics

Did a message appear
on the device stating
that the license was out
of date or invalid?

YES

Install a valid license
file by following the
instructions in
Appendix D of the
manual and restart
the device

NO

Did a message appear
stating that a critical
license file is missing
from the device?

YES

NO
Press the Autofit/
Help Button to bring
up the Autofit/Help
menu and select
Autofit

Did the trace
appear on the
screen?

NO

YES

PASSED

FAILED
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C.3.7

TDR Trace Verification

Start TDR Pulse
Diagnostics

Return to Main Menu and navigate
to SettingsàDiagnostics and select
Analog. Attach a shorted
terminator and press OK

Did all tests
displayed pass?

YES

Using an oscilloscope,
verify the TDR pulse
characteristics as
described in “Operator
Performance Checks”

NO

NO

Are the pulse
characteristics within
the device’s
specifications?

YES

Enable temperature
display. This can be
found under the
Main Menuà
SettingsàDisplay

Do temperatures update
on-screen, and within ± 15ᵒ of
ambient?

NO

YES
Verify the Vertical
Accuracy per the
“Operator Performance
Checks”
FAIL

PASS
Attach a 50 ohm test
cable of known
length and set Vp to
match the pulse
velocity of the cable

FAIL

Measure the length
of the cable for
Short, Medium, and
Long Cable Length
Settings

Do distance
measurements meet
specification?

PASS

FAILED
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TDR Trace
Verification Passed
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C.3.8

USB Client and Ethernet Verification

START

Connect back USB to
known working PC
with CT Viewer 2
installed.

Does the
PC recognize the
device?

NO

YES
Connect known
working Ethernet
cable that is
connected to a
network to the
device. Watch
Ethernet lights on
back.

Do Ethernet
lights blink?

NO

YES

PASSED

FAILED
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C.3.9

Real Time Clock Verification

Start

Navigate to
Main Menu
Settings
Info
Time

Change the date
and time and select
OK

Turn power off,
then restart the
device

Does the
device display the
new time?

YES

NO

Reset Correct Date
and Time

PASSED
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FAILED
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C.3.10

File IO Verification

START

Verify that only the live TDR trace is on
the display. Enclose the leading edge of
the live trace with the two cursors and
generate a cursor scan. See section
3.11.5 for instructions on creating a scan.

While in the SCAN
menu select SAVE.
In the Save Trace
dialog, use the
keyboard to enter a
name for the trace.

Attach a USB
Keyboard to the
front of the device

NO

NO

Does the
keyboard work?

Does cable scan
records list a
collection of saved
traces?

Navigate to File →
Cable Scan Records

YES

YES

YES

After entering a
name for the
scanned trace, press
OK

Export the traces
using a USB drive or
CT Viewer and then
delete the traces on
the device

Did the trace fail
to save due to
insufficient space?

Attempt to save the
scanned trace again.

NO

Did the trace save
successfully?

YES
NO

Hide the saved trace and
attempt to reload the
saved trace. See section
3.11.8 for instructions on
loading a saved trace.

NO

Did the trace
load correctly?

YES
FAILED
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C.4. Parts List

Subassembly
CT100B

Table C.1. Parts List
Item
Part No.
CT100B

Qty.

1
2

1
1

Front Panel Assembly

CT290B

1

W2W7C1

1

2

W1W9C1

1

Analog-Digicomp Assembly

CT208B
1

A1

1

2
3
4
5

A2A1
A2A3
A2A4
W2W1C1

1
1
1
1

6

W2W3C1

1

7

W2W3C2

1

Back Panel Assembly
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CT291
CT292

CT209B

1

CT100-AC-B2700

1

2

W1W5C1

1

3
4

W2W6C1
W2W6C2

1
1

5

W2W6C3

1

Description
CT100B TDR
Cable Tester
Rear Housing
Front Cover
LCD display, front
control board,
switches, cables,
and knobs
Digicomp-video
PCB FFC 40 pin
flat-flex 0.5mm
space
Coaxial Cable
Assembly
Analog-Digicomp
Assembly
Analog Board
Assembly
Digicomp Board
microSD Card
Clock Battery
Digicomp to Analog
Board FFC
Serial Port Cable
Assembly, Front
USB Host Cable
Power board, back
bezel, battery,
cables, and fan
Battery set NiMH
with thermistors
(2700 mA·h)
Analog Power
Cable
Ethernet cable
Ethernet LED
Cable
USB client cable
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D. Maintenance and Service Instructions
D.1. Cleaning and Lubrication
Ensure that the CT100B power is off before cleaning. Clean the CT100B with a
damp cloth. Clean the LCD screen with LCD screen cleaner or optical lens
cleaner. Do not use any powerful solvents when cleaning the CT100B.
The CT100B does not require lubrication.

D.2. Cleaning and Lubrication Interval
Clean as necessary. The CT100B does not require lubrication.

D.3. Battery Removal/Replacement
1. Ensure that the CT100B is powered off.
2. Remove all external devices and power connections from the instrument.
3. Apply the front cover (part CT292) and lay the instrument face down on a
smooth surface.
4. Remove the two cross-top screws from the rear of the instrument.
5. Swing the handle to the back of the instrument.
6. Using a long handled cross-top screwdriver, remove the two pairs of screws
from both ends of the instrument nearest the handle mounts.
7. Carefully remove the rear housing (CT291) from the front panel (CT290B),
using the handle for gripping. The housing may be tight and the rubber
feet may momentarily catch while they slide past the metal frame.
8. The battery pack should now be exposed at the lower rear of the
instrument.
9. Unclip the 3-pin battery connector by pressing on the release tab and
pulling on the connector housing.
10. Remove the two cross-top screws mounting the battery clips (part CT112)
to the chassis.
11. Lift the battery pack out.
To re-install or replace the battery, repeat the above steps in reverse order.

D.4. Calibration and Calibration Interval
The recommended calibration interval is 1 year and operator performance checks
should be completed every 6 months. See Appendix B for instructions on how to
determine if your instrument should be calibrated between scheduled
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calibrations. A detailed calibration procedure is found in the CT100B Technical
Manual.

D.5. Install CT100B License
The CT100B license can be installed on the device using either CT Viewer 2 or
a USB Flash drive.

D.5.1

Install License Using CT Viewer 2

1. On a computer with CT Viewer 2 installed, start up CT Viewer 2 by
double-clicking on the icon.
2. Power on the CT100B and let it boot completely.
3. Connect the CT100B to the computer using either USB or Ethernet from
the back of the device. See Section 4 for instructions on connecting to a
CT100B over Ethernet.
4. In CT Viewer 2, click on Help → Install License.
5. Select the license file sent by MOHR.
6. Click OK .
7. After receiving a message of a successful install, restart the device.

D.5.2

Install a License Using a USB Flash Drive

Note: If multiple license files are on a USB flash drive, the CT100B will reject
the file. Make sure the intended license file is the only MOHR license file on the
drive.
1.
2.
3.
4.
5.

Copy the file to an empty USB flash drive. (Do not change the file name.)
Power on the CT100B device and let it boot completely.
Attach the USB flash drive to a front USB port on the CT100B.
Push the blue button (Main menu button) to bring up the Main menu.
Using the soft-menu buttons, navigate to Settings → Info → License →
License from USB.
6. After receiving a message of a successful install, restart the device.

D.6. Clean Storage
The CT100B has a large storage capacity, but if more space is needed, perform
the following steps to clean the internal storage of the CT100B.
1. Delete saved traces following the instructions in Section 3.11.9.2. If
desired, first archive the traces by transferring them to CT Viewer 2.
2. After removing the scans, clean the database with Settings → Diagnostics
→ Database → Clean Database.
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E. Vp of Common Cables
E.1. Cable Types
Commonly encountered cable designations, along with their associated
characteristic impedances and typical Vp values, are listed below. A more
complete listing is stored in the CT100B’s internal memory. Note that the
actual Vp of a given cable can vary by manufacturer, manufactured lot, cable
age and condition, whether it is flat or coiled on a roll, and other variables. The
most accurate way to test a cable is to determine the Vp of the cable using the
CT100B and a known length of the cable you wish to test. See Section 3.10.3 for
more information on determining the Vp of a cable.

E.2. Dielectric Material
Table E.1. Vp of Common Dielectric Materials
Type
Probable Vp
Jelly-filled
0.64
Polyethylene
0.66
PTFE / TFE
0.70
Pulp
0.72
Foam / cellular PE
0.78
Semisolid PE
0.84
Air
0.98
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E.3. RG Standards
Table E.2. Vp of RG Standards
Designation
Z0 (ohms)
RG-6/U
75
RG-6/UQ
75
RG-8/U
50
RG-9/U
51
RG-11/U
75
RG-58/U
50
RG-59/U
75
RG-62/U
92
RG-62A
93
RG-174/U
50
RG-178/U
50
RG-179/U
75
RG-213/U
50
RG-214
50
RG-218
50
RG-223
50
RG-316/U
50
RG-393
50

Vp
0.66
0.66
0.66
0.66
0.66
0.66
0.66
0.84
0.84
0.84
0.69
0.67
0.66
0.66
0.66
0.66
0.66
0.66

E.4. MIL-C-17 Standards
Table E.3. Vp of MIL-C-17
Designation
M17/2-RG6 (RG-6/U)
M17/163-00001 (RG-8/U)
M17/6-RG11 (RG-11/U)
M17/155-00001 (RG-58/U)
M17/29-59 (RG-59/U)
M17/173-00001 (RG-174/U)
M17/169-00001 (RG-178/U)
M17/094-RG179 (RG-179/U)
M17/172-00001 (RG-316/U)
M17/127-RG393 (RG-393/U)
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Standards
Z0 (ohms)
75
50
75
50
75
50
50
75
50
50

Vp
0.66
0.66
0.66
0.66
0.66
0.84
0.69
0.67
0.66
0.66
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E.5. Commercial Designations

Table E.4. Vp of Commercial Designations
Designation
Z0 (ohms)
H155
50
H500
50
LMR-200
50
HDF-200
50
CFD-200
50
LMR-400
50
HDF-400
50
CFD-400
50
LMR-600
50
LMR-900
50
LMR-1200
50
LMR-1700
50

Vp
0.79
0.82
0.83
0.83
0.83
0.85
0.85
0.85
0.87
0.87
0.88
0.89

E.6. Twisted Pair
Table E.5. Vp of Twisted Pairs
Designation
Z0 (ohms)
CAT5
100
CAT6
100
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Glossary
Aberrations Imperfections or undesired variations in a signal. For example,
aberrations in a TDR’s excitation signal are the result of the finite
switching speed of the instrument’s electronics and cause it to deviate
from a perfect step signal.
AC Alternating current, a method of delivering electrical energy by periodically
changing the direction of the electric field in a conductor.
Accuracy The difference between a measured or estimated value of a quantity
and its true value. Accuracy and precision are both important factors to
consider when assessing the reliability of a measurement.
Analog Refers to a signal that is continuous with respect to both time and
value. Analog circuitry produces and/or measures analog signals. This is
in contradistinction to digital signals, which are discontinuous in both time
and value. The sampling circuitry of a TDR converts the analog voltage
signal detected on a cable to a digital value for representation on the
display and in the instrument’s memory.
Cable Conductors of electricity that are usually shielded and insulated. Cables
typically contain at least two conductors, one to deliver the electrical
signal and one to act as the return path. The conductor acting as the
return path may be referred to as the “shield,” “ground,” or “ground wire”.
A cable with such a ground return path is known as an unbalanced cable,
an example of which is typical coaxial cable. Another general type of cable
is called balanced cable, an example of which is twisted pair Ethernet
cable. In balanced cable, two signal wires carrying differential signals of
opposite polarity are both separated from ground by an equal impedance.
Cable Attenuation A quantity describing the energy in a signal that is absorbed,
reflected, or otherwise lost during propagation through a cable. Higher
frequencies are typically the most susceptible to attenuation. Cable
attenuation can distort some TDR measurements. Attenuation is often
expressed in decibels (dB) at one or more frequencies. See also dB
and Return Loss.
Cable Fault A defect in a cable or other condition that makes a cable less able
to deliver electrical energy than was designed. Damage to the shield,
conductor, or insulation, bad splices, and poorly mated connectors are
frequently encountered cable faults.
Capacitance See Reactance
Characteristic Impedance The ratio of the amplitude of voltage and current in
an electrical signal propagating in a cable. In a coaxial cable, this value
(usually written Z0 ) is, in large part, related to the geometrical
relationship of conductor to return path conductor. Cables are usually
designed to match the impedance of the source and load to which they are
attached in order to maximize power transfer.
Conductor A substance that allows electricity to flow through it with minimal
resistance. Most conductors are metals. However, there are many
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non-metallic conductors, including salt solutions, graphite, and any
element in its plasma state.
dB dB is the abbreviation for decibel. Decibels are a method of expressing
power or voltage ratios as logarithms. When used for voltage ratios, as in
TDR, the formula for decibels is dB = 20 · log10 (Vi /Vr ) where Vi is the
voltage of the incident pulse and Vr is the voltage reflected back by the
load. The dB vertical scale on the CT100B refers to the amount of voltage
gain the instrument applies to the signal before displaying it. For example,
when the instrument is amplifying the voltage by a factor of 100, this
indicator would read: verticalscale = 20 · log10 (100) = 40dB.
DC Direct current is unidirectional flow of electrical current. The term DC is
also synonymous with constant; for example, a perfect DC voltage source
does not vary from a set value. Batteries are an example of a DC voltage
source.
DHCP Dynamic Host Configuration Protocol. Used in computer networks to
automatically assign network settings to computers.
Dielectric A nonconducting substance or insulator. May also refer to the
dielectric strength or relative permittivity of a medium, which is a measure
of the electrical energy stored by a medium when an electrical potential of
a given frequency is applied across it. See also Insulation.
Digital Refers to signals in which information is represented by variables that
are discrete or discontinuous both in time and in value. This is in
contradiction to an analog signal, which is continuous both in time and
value.
Domain A mathematical term that refers to the set of values for which a
function is defined. A time-domain instrument such as a TDR performs its
function by recording measurements as a function of time.
DUT Device Under Test. The DUT is the electrical cable, device, or network
that is attached to the port of the CT100B. It is the object to be measured.
FFT The Fast Fourier Transform algorithm is a fast method of performing a
discrete Fourier transform on a time history. A Fourier transform converts
time-domain data into the frequency domain. Since the CT100B always
uses the FFT algorithm, the term is used in this manual to describe both
the algorithm and its outputs. An “FFT Trace” is a frequency domain
trace created by running the FFT algorithm on a TDR trace.
Impedance The ratio of voltage to electrical current in a cable or circuit.
Impedance is a frequency-dependent value that is influenced both by
resistive and reactive components. Impedance is expressed in terms of
ohms but should not be confused with resistance, which is a frequency
independent quantity. Most cables have impedances that vary little over
the range of frequencies with which they are used. Impedance is described
by Z = R + j · X where R is resistance, j is the imaginary unit, and X is
the reactance at a given frequency. See also Reactance and Resistance.
Impedance Mismatch A point in a cable or device under test in which the
characteristic impedance changes, causing a partial reflection of the energy
in a test signal. See also Reflection Coefficient.
Incident Pulse The excitation pulse produced by a TDR and injected into the
cable under test. The trace produced by the TDR is the
temporally-resolved reflections produced by the cable in response to the
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incident pulse. The incident pulse in the CT100B is a step rise signal with
a finite rise time. See also Rise time.
Inductance See Reactance.
Insulation A coating on an electrical conductor that inhibits the flow of
electricity. Insulation serves as both a means of providing electrical safety
and ensuring signal integrity.
IP Internet Protocol. The universal protocol used to send data through the
internet. Also used in many other computer networks. Each computer on
a network must have a unique IP address.
Jitter The uncertainty in measurement of time in a TDR. The main effect of
jitter is to cause apparent vertical noise in areas of changing impedance.
Areas of constant impedance, such as a flat segment of 50 Ω cable, will
show no abnormality.
Layer Peeling A mathematical technique for reducing multiple reflections in a
TDR trace. TDRs measure reflections from changes in impedance, but if
there are multiple impedance changes, then the reflections from one will
partially reflect back off of another. Reducing the effect of these extra
reflections improves the measurement of the impedance changes.
LCD Liquid crystal display. The display used by this instrument is an
active-matrix thin-film transistor LCD, abbreviated TFT-LCD.
Millirho (mρ) See Reflection Coefficient.
Noise Any undesirable electrical energy that impairs the ability of an electronic
system to transmit or receive a signal or make an accurate measurement.
In TDR, noise is typically related to thermal and/or electrical noise that
interferes with the time base or sampling circuitry and is usually random,
although a nearby strong electromagnetic radiator can cause non-random
synchronous noise to be measured on unshielded cable. In the case of
random noise, averaging is an effective means of noise suppression.
Open Circuit Describes a non-terminated cable or cable with a broken conductor
that reflects all energy within the incident pulse.
OSL (Open Short Load) A method of calibrating one port analyzers using
precision open, short and load terminations, where the load matches the
output impedance of the analyzer. Each termination contributes to
reducing error in an S11 measurement.
Phase A horizontal shift in a sinusoid. Phase is given as an angle. A sinusoid
with phase of π radians (180 degrees) is precisely inverted compared to the
same sinusoid with 0 phase. A sinusoid with phase of 2π radians (360
degrees) is precisely equal to an the same sinusoid with 0 phase, i.e. it has
no phase shift.
Precision The variation in the value of a variable measured multiple times.
Precision and accuracy are both important factors in determining the
reliability of a given measurement. Precision may also be used to describe
the number of digits or the unit of the least significant digit with which a
particular quantity is expressed.
Reactance The imaginary component of electrical impedance. Reactance
describes the opposition of a conductor to the flow of alternating current.
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Impedance is described by Z = R + j · X where R is resistance, j is the
imaginary unit, and X is the reactance at a given frequency. If X > 0, the
impedance is inductive, if X = 0 then the impedance is purely resistive,
and if X < 0 the impedance is capacitive.
Reflection Coefficient In TDR, a coefficient describing the amplitude of a
reflected signal produced by an impedance mismatch in relation to the
incident pulse. The reflection coefficient Gamma (Γ) is defined by the
relation Γ = (Zt − Z0 )/(Zt + Z0 ) where Zt is the impedance at time t and
Z0 is the characteristic impedance of the cable, and is usually described in
parts per thousand with units of rho (ρ) or millirho (mρ). The coefficient ρ
ranges from -1 (short circuit) to +1 (open circuit). A reflection coefficient
of zero indicates that there is no impedance mismatch and no reflection of
electrical energy.
Reflectometer An instrument that measures reflections to determine the state of
a system. The CT100B measures the reflections of electrical energy.
Resistance A conductor’s opposition to electrical current. The reciprocal of
resistance is conductance. Electrical resistance can often be considered a
constant that does not vary with respect to the voltage or current applied
to an object. When considering the impedance of a circuit element,
resistance is also frequency invariant. Most materials, including
conductors, have some degree of electrical resistance. A special class of
materials called superconductors demonstrate zero electrical resistance.
Resolution For a given parameter, the smallest increment that can be measured
or displayed. In the setting of TDR, resolution may refer to time base
resolution, which describes the smallest increment of time used by the
pulser-sampler system to produce signals and measure reflections, or
spatial resolution, which is dependent on the system rise time and
determines the ability of the TDR to separate two closely spaced cable
faults.
Return Loss A measure of the power reflected by impedance changes in a cable.
Return loss is typically expressed as a logarithm of the reflection
coefficient, ρ: RL(dB) = −20 · log10 |ρ| where RL is return loss. Cable
faults such as shorts and opens, which return all of the incident energy in
the TDR signal, have return losses of 0 dB.
Rho (ρ) See Reflection Coefficient
Rise time With respect to the incident pulse, the time required for the signal to
change from 10% to 90%, or alternatively 20% to 80%, of its final value.
With respect to the sampling electronics, the time required for the
sampled value to change from 10% to 90% of the final value when a perfect
step signal is applied. The rise time of a pulser-sampler system is
approximately equal to the root sum of squares of the pulse and sampler
rise times.
RMS An acronym for Root Mean Square, also abbreviated rms and known as
the quadratic mean. This is a useful statistical technique when considering
time varying electrical quantities for which simple DC definitions are not
accurate, such as when determining the power dissipated by an AC source.
The formula for calculating an rms value of a given time-varying signal is:

r
xrms =

x21 + x22 + x23 + · · · + x2n
n

where xi represent discrete samples and n is the total number of samples.
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S11 A scattering parameter that measures complex return loss on port 1 of a
linear electronic device. See Scattering Parameters.
S21 A scattering parameter that measures complex transmission loss from port
1 to port 2 on a linear electronic device. See Scattering Parameters.
Sampling Efficiency The CT100B makes measurements through a process known
as sequential sampling. In sequential sampling, a succession of incident
pulses followed by discrete samples progressively builds up a given TDR
trace. Sampling efficiency describes the ability of the sampling circuitry to
adjust to rapid changes in impedance within a TDR trace. Low sampling
efficiency leads to a trace that appears too smooth.
Scattering Parameters Scattering parameters are the complex ratios of output
signal to input signal for a linear electronic device. For a device with two
ports, four scattering parameters may be generated: S11 , S21 , S12 and S22 .
A one port device has only one parameter, S11 , while a four port device
has 16. S11 is the complex ratio of output at port 1 to an input at port 1.
S21 is the complex ratio of an output on port 2 to an input on port 1, and
so on. The assignment of port 1 and port 2 is arbitrary. A full set of
scattering parameters are considered a complete characterization of a
linear device for the frequency range of the scattering parameters.
Short Circuit The condition in which the conductor in a cable or circuit comes
into direct contact with the return path conductor or earth ground. The
electrical length of the cable measured by TDR is shortened to the point of
the short circuit.
Smith Chart A method for displaying complex valued electrical measurements,
such as an S11 , on a polar plot, graphically showing both magnitude and
phase angle.
Smoothing Any technique for reducing noise in a signal. The CT100B uses time
averaging to smooth traces.
SP232 A serial protocol used by the Tektronix 1502B and 1502C. This protocol
allowed transmission of TDR trace data across a serial port. Using a USB
to serial port adapter, a CT100B can emulate this protocol.
Stability The change in the accuracy of a measurement or piece of test
equipment over a period of time such as the calibration interval. Stability
may also refer to changes in accuracy related to a specific environmental
influence such as vibration, temperature, or humidity.
TDR Acronym for Time-Domain Reflectometer or Reflectometry. TDR
instruments use a form of closed-circuit radar to detect cable faults. A
series of pulses are sent into a cable and reflected voltage is measured as a
function of time. If the velocity of propagation (Vp) is known, the length
of a cable and the distance to cable faults can be determined. TDR traces
produced by step-rise TDRs like the CT100B describe the impedance of a
cable along its length and can accurately detect a wide range of cable
faults that can impair high-frequency analog/RF and digital
communications systems.
Trace A displayed or stored signal. When displayed, a trace appears as a line
across the screen. A trace may be a direct TDR measurement, as with the
live trace, or derived trace, such as a difference trace or an S11 trace. A
trace is sometimes referred to as a “waveform”. A scanned or saved trace
may be called a “scan”. A trace is a visual representation of the waveform
generated by a TDR. Traces on the CT100B may be in either time or
frequency domain depending upon their purpose.
Trace Averaging See Noise.
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USB Universal Serial Bus. A common system for connecting a peripheral, such
as a printer, phone, or CT100B to a computer.
Velocity of Propagation (Vp) Velocity of propagation of an electrical signal
within a cable as a fraction of c, the speed of light in a vacuum. Coaxial
cable usually has a Vp of between 0.6 and 0.9.
Vertical Reference (Vert Ref) A feature of the CT100B that improves vertical
measurements by referencing them to scans from short and open
calibration terminations.
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.csv, 45
AC power, 5
adapter plugs
voltage, 10
add server, 69
assistant mode, 70
auto-update, 28
balun
see Vert. Ref. calibration, 51
battery
battery packs, 1
charge capacity, 89
charging circuit, 10
charging test, 97
charging time, 88
disposal, 7
low battery, 11
operating time, 88
proper care of the battery, 10
removal and replacement, 109
temperature restrictions, 10
trickle charge, 10
battery disposal, 7
breaker
manual, 5
thermal, 5
brightness, 17
button
AUTOFIT/HELP, 13
CURSOR, 13, 21
FILE, 13, 21
H1, 12
H2, 12
H3, 12
H4, 12
M-FUNC, 13, 16
MENU, 12, 22
POWER, 12
SCAN, 13, 17, 41
SELECT, 13, 20
V1, 13
V2, 13

V3, 13
V4, 13
cable fault
common types, 72
distance to fault, 36
cable loss (S21 ), 82
cable resistance correction, 52
cable scans, 39
cable type, 63
change units, 64
charging the battery, 10
compound cables, 38
configurations, 65
load, 66
reset, 20
save, 66
connectors
24 VDC power adapter plug,
14
BNC connector, 13
client USB, 14
rear panel, 13
RJ-45 Ethernet port, 14
USB port, 13
controls
front panel, 12
keyboard, 14
soft keyboard, 15
USB keyboard, 14
covers, 7
CT Viewer, 23, 44, 67
connecting over Ethernet, 68
movie, 70
remote control, 63, 70
working with USB drive, 67
damage
due to electrostatic discharge,
9
due to static charge, 4
during shipping, 2
improper grounding, 4
deleting a trace, 45
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difference trace, 49
display
features, 16
distance to fault, 36
DUT
connecting, 30
dynamic deconvolution
create trace, 61
theory, 83

knob
HORIZONTAL POSITION,
13
HORIZONTAL SCALE, 13
M-FUNCTION, 13
VERTICAL POSITION, 12
VERTICAL SCALE, 13

electric shock, 6
electrostatic discharge
damage from, 9
envelope plot, see trace, envelope
plot
environmental specifications, 89
explosive atmosphere, 6
exporting a trace to .csv, 45
exporting a trace to file, 44
Fast Fourier Transform (FFT), 62
FFT, see Fast Fourier Transform
fine Vp control, 64
first derivative, 50
floating, 6
floating ground, 6
functional block diagram, 97
fuses, 5
grounding
floating ground, 6
grounding the BNC
connector, 6
loss of ground, 6
Help menu, 20
impedance, 75
at cursor, 39
resistive loss correction, 52
toggle on/off, 29
impedance matching adapters, see
Vert. Ref. calibration
insertion loss
frequency domain (S21 ), 81
inspection, 2
intermittent fault detection, 48
jitter, 87
specification, 87
keyboard, 14, 15
keyboard shortcuts, 14
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layer peeling
create trace, 61
theory, 83
license code, 11, 110
live trace data, 62
loading a trace, 42
loss of ground, 6
low battery, 11
maintenance
calibration interval, 109
manual breaker, 5
mask, 45
create, 46
deleting, 47
exporting and importing, 47
loading, 47
saving, 46
testing, 45
mask testing, 45
mechanical shock, 9
menu
AUTOFIT/HELP, 20
FILE, 21
Info, 11
Math, 18
Power, 10
Scan, 17
top-level menu, 22
multisegment cable, 38
navigating dialog boxes, 15
network settings, 68
noise
specification, 87
normalized TDR trace, 60
theory, 82
ohms at cursor, 39
operating temperature, 9
options and accessories, 85
panels, 7
performance check, 28, 91
phase stable cable, 58
Power menu, see menu, Power
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power requirements
AC power, 1
external AC power adapter, 1
internal power, 1
print screen, 22
reflected rise time, 87
reflection coefficients, 71
theory, 71
toggle on/off, 29
relative distance, 36
relative reflection coefficient, 65
remote control, 63, 68, 70
repacking, 2
resistive loss correction, 52
resolution, see sample resolution
return loss
frequency domain (S11 ), 81
return loss (S11 ) options, 54
aberration filter, 54
align base traces, 58
between cursors, 56
calibration standards, 56
hide calibration traces, 58
noise filter, 55
phase correction, 55
return loss waveforms (S11 ), 52
rise time, 60, 78
specifications, 87
RMA
repacking, 2
safety, 3
terms and symbols
CAUTION, 3
DANGER, 3
symbols in manual, 4
symbols on product, 4
WARNING, 3
sample resolution, 34
sampling efficiency, 87
scans, 39
screenshot, 62, 66
scrolling dialog boxes, 16
second derivative, 50
secondary reflections, 58
selecting a trace, 41
setup, 15
date and time, 15
shift, 17

Smith chart
creating, 59
theory, 82
soft keyboard, see keyboard
specifications, 87–89
static charge
damage to BNC connector, 13
grounding the BNC
connector, 6
storage temperature, 9
storing a trace, 41
switches
power, 14
TDR, 1, 71
temperature
correction, 35
operating, 9
storage, 9
temperature correction, 35
thermal breakers, 5
time-domain gating, 56
time-domain reflectometry, 1, 71
trace
create a cable scan, 39
delete, 45
difference, 49
distance to fault (DTF), 36
envelope plot, 48
export to .csv, 45
export to file, 44
FFT, 62
first derivative, 50
hide selected trace, 17
layer peeling, 61
loading, 42
multisegment velocity of
propagation, 38
normalized TDR trace, 60, 82
S11 return loss between
cursors, 56, 58
scan a cable, 39
scan mode, 40
selection, 41
smoothing, 33
storing, 41
transfer, 44, 67
trace scans, 39
transferring a trace, 44
troubleshooting, 97
troubleshooting flowchart, 97
units, 64
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unpacking, 2
USB
send traces, 68
USB drive
save waveform, 67
velocity of propagation
AUTOFIT/HELP button, 32
changing the value of, 31
finding an unknown, 32
for common cable types, 111
load a cable type’s Vp, 63
load and save custom cable
types, 64
multisegment cable, 38
theory, 74
Vert. Ref. calibration, 50
vertical reference, 50
vertical units, 64
vibration, 9
voltage standing wave ratio
(VSWR), 77
create VSWR trace, 18
toggle VSWR at cursor, 29
water hazards, 9
water spray, 9
watertight, 9
web export, 62
web server, 62
WiFi, 54
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